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In This Guide

This guide contains the instructions to deploy Mobile Subscriber Activation (MSA) HP Business Solution
Pack v7.0.0 and to adapt off-the-shelf solution to specific environments.

This manual falls in the following parts:

— Architectural Introduction.
— Installation processes.
— Configuration of the features available off-the-shelf in MSA.

— How to extend the set of MSA functionalities.

Audience

The audience for this guide is the Solutions Integrator (Sl). The Sl should have a combination of some or
all of the following capabilities:

Understands and has a solid working knowledge of:
— UNIX® commands.
— Windows® system administration.

Understands networking concepts and language.

Is able to program in Java™ and XML.

Understands security issues.

Understands the customer’s problem domain.

References

Other manuals for HP Mobile Subscriber Activation Solution Pack v7.0.0:
e HP Mobile Subscriber Activation SP v7.0.0 - Services Specifications.
e HP Mobile Subscriber Activation SP v7.0.0 — User’s Guide.

Manuals for HP Service Activator V7.0 or upper:

e HPSA Service Activator Installation Guide.

e HPSA Extension Pack Installation Guide.
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1

Architectural Introduction

MSA is a preconfigured solution based on HP Service Activator to activate mobile services.

MSA offers a set of configured mobile services that can be used off of the shelf as well as a set of
modules that allow the inclusion of new services in an easy way and on the fly. In the way MSA could be
infended as a framework where new services could be included without the need of compile new source
code.

Additionally due MSA is intended for the mobile environment, is a solution that supports a high
performance as well as is a scalable solution

The next figure shows the MSA’s components in a logical view. This view shows the process that a service
request follow since it is received in the northbound interface until the services are activated into the
target.

interface to
accept service
orders

Service order
decomposition

Activation
workflows

Plug-insto
communicate
with the target
systems

Figure 1 — MSA architecture

In the next bullets are explained each of these components.

1.1 Northbound Interface

Out-ofthe-box MSA offers a generic northbound interface to integrate it with an order management
system. This generic northbound interface is the ones used to integrate MSA with the HP Order
Management Mobile Solution Pack.

This generic northbound interface defines a service request as a service identifier and a set of parameters
define as pairs name/value.
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<service>
SERVICE ACTION 1
Parameterl:valuel
Parameter2:value2
Parameter3:value3
Parameterd:valued
</service>

This generic definition allows using the same interface for all the services defined in the service catalog.
Additionally this interface allows combining multiple services in a single request and allows the user
defined the execution mode. The next picture shows an example of complex service request:

l.'van Error: Rollback, Continue, Abort
./ ¥Execution mode: Serial, Parallel <services

| VDere . )
L Persistence: Enable, Disable DYNAMIC SERVICE ORDER
mode="parallel"

¥ Invocation: Synchronous, Asynchronous
onerror="rollback”

persistence="enable">
<service>

SERVICE ACTION 1
[ ] [ ] [ ] Parameterl:valuel
Parameter2:value2
Parameter3:value3

¥ Type .
>Parameterl—__| | ¥'Format Parameter4:value4
FParameter2 | ¥ Defaultvalue </Service>
FParameter3 ¥ Mandatory? )
>Parameterd ¥ Overwrite input value? <service>
S SERVICE ACTION 2

Parameterl:valuel
</service>
<service>
SERVICE ACTION 3

Parameterl:valuel
Parameter2:value2
Parameter3:value3
</[service>
<services/>

On the left if represented the logical structure of the service, in this case the complex service is composed
by 3 single services represented by Service Action 1, 2 and 3. This single service must be defined in the
service catalog.

On the right side of this figure is represented the pseudo structure of the request that must be used to
invoke this service.

Due the composition of a complex service request is generic the complexity of it could be as higher and
the customer need. The next figure shows an example of complex service request, where the single service
actions are combined in some different ways.
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Dynamic

Service Order

Serial,
Continue

Serial,
Abort

Parallel,
Rollback

D 8 ©8 £

1.2 Service Catalog

MSA offers offthe-shelf a set of mobile services. These services cover most off the services used by the
Mobile Service Provides.

As MSA is between the commercial representation of a service and the physical implementation the
service on the network, MSA offers an abstraction layer of the physical definition of a service in the
targets.

The next picture shows most of the services included in the service catalog:

v Type
vFormat
v'Defaultvalue
v'Mandatory?

0 . ¥ Overwrite input value?
Voice Mail

Create

Voice Mail Voice Mail Voice Mail
Delete Set Get

HLR HSS AUC EIR
Create... Create... Create... Create..

MCA Blackberry OTA OTABK
Create... Create... Create... Create...

SM DM PTT OTA
Create... Create... Create... Create...

0]
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For each service is defined the list of parameters needed to activate the service in target. For more details
about the parameters defined for each service see the Appendix on this document.
Each service include in MSA is defined in the service catalog as a single service action therefore can be

combined to create a complex service request composed by multiples single services. The next picture
shows an example of a complex service request to create a typical mobile subscription on the network:

o
=, ¥ Execution mode: Serial, Parallel
| ¥'Persistence: Enable, Disable

[ J :“/On Error: Rollback, Continue, Abort

1.3 Activation Workflows

The business logic used to activate the services included in MSA is implemented in the activation
workflow; these are HP Service Activator workflows.

Each workflow executes a set of step to complete the activation of a service. The next figure shows the
mains steps of all the MSA's workflows:

If error

This is the description of each step:

First step is the reception of the input parameters received in the northbound interface, next based on the
parameters the workflow select the correct platforms where the service must to be activated. The selection
of the platform is based on a predefined mappings, that allow the customer distribute the subscriptions
into the available platforms.

Once the right platform has been selected, the workflow queries some characteristic of this platform as the
access information and the target version. Based on this information the workflow selects the correct
plugin to execute the activation into the target.

The activation is execute with a different node depends on the technology supported for the target.
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After the activation took place, the workflow receive the response from the target, this response is
evaluated in the workflow and returned to the northbound systems. In case of error the workflow translate
the target error code into a meaningful code and description and return it fo the northbound system.

In the workflow if selected all the information that will be stored in the history database.

All the queries executed in the workflows are done using a cache avoiding access directly to the
database.

1.4 Services Specifications

These are the services include in the MSA service catalog:

Activation of Voice and Data Mobile services on HLR over EMA of Ericsson.
Activation of subscriptions on AUC and EIR over EMA of Ericsson.
Activation of LTE (4G) services over HP HSS.
Activation of Number Portability service (MNP) over Huawei targets.
Activation of Value-added services (VAS)

o Voice Mail (VM) and Missed Call Alerts (MCA) over ZTE targets

o Push to talk (PTT) service over Kodiak targets.

o OTA and OTA Backup service over Gemalto targets

o Blackberry service over RIM targets.

Activation of operator services, these services are used by the Mobile Service Provider to manage
some aspect of the subscriptions.

o Device Manager (DM) over Gemalto targets.
o Service Manager (SM) over Gemalto targets.

o Service Delivery Platform (SDP) over Huawei targets.

For all of these services MSA offers the translation from the logical service definition offer in the
northbound interface, and the physical activation of the service into the network targets.

Additionally MSA offer some other features related with the services:

Service Definition, for each service are defined all the operation supported by itself and also are
defined all the parameters supported for each operation. The parameters definition includes type
and format validations as well as the capability to define a default value.

Error Management, for each service MSA manages all the potential errors returned by the target
and a translation into a meaningful description of it.

For more information about the service definition, please review the MSA delivery guide (HP Mobile
Subscriber Activation SP v7.0.0 - Services Specifications), there you can found a complete
definition of all the services include in MSA.

10



HP Mobile Subscriber Activation Solution Pack v7.0.0 - Delivery Guide

2 Installation

2.1

Prerequisites

Prerequisites for MSA Solution are:

2.2

HP Service Activator 7.0 or upper and the latest available patch successfully installed.

The CRModel solution must be deployed on HPSA.

The Extension Pack 7.0 or upper for HPSA must be installed.

Install MSA

In order to deploy the MSA solution, ensure that the prerequisites described in the previous section are
met and then follow the steps below:

11

1.
2.

VW ® N o U0~ ©

Copy the provided MSA zip file into the $ACTIVATOR_OPT/SolutionPacks directory.

Ensure that HPSA is not running, otherwise stop it now. For more information on stopping and
starting the HPSA service, refer to section “Starting and Stopping Service Activator”
in the HPSA Installation Guide.

Run the deployment manager from the $ACTIVATOR_OPT/bin directory.

Click on System Database Connection and enter database credentials, then click OK.
Click on Local Deployment.

Click on Import Solution.

Select from zip/tar file and browse for SolutionPacks/MSA .zip.

Click on Import.

Click on Deploy Local Solution.

. Select the MSA Solution.
11.

Select the appropriate deployment file depending on the version, the database and the
operating system (see the table below).

Deployment file HPS.A Database Operating Test
version System

deploy_7_0_0_oracle.xml 7.0.0 | Oracle Windows No
deploy_7_0_0_ppas.xml 7.0.0 | PPAS Windows No

(Postgres

Plus

Advanced

Server)
deployTest_7_0_0_oracle.xml 7.0.0 | Oracle Windows Yes
deployTest_7_0_0_ppas.xml 7.0.0 | PPAS Windows Yes
deploy_upgrade_6_x_to_7_0_0.xml* 7.0.0 | Any Windows Any
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deployUnix_7_0_0_oracle.xml 7.0.0 | Oracle Unix No
deployUnix_7_0_0_ppas.xml 7.0.0 | PPAS Unix No
deployUnixTest_7_0_0_oracle.xml 7.0.0 | Oracle Unix Yes
deployUnixTest_7_0_0_ppas.xml 7.0.0 | PPAS Unix Yes
deployUnix_upgrade_6_x_to_7_0_0.xml* | 7.0.0 | Any Unix Any

12. Check Create inventory tables.
13. Click on Deploy solution.

Deployment of the solution is now complete but additional configuration steps are required. Please review
the Configuration section for more information.

2.3 Contiguring MSA installation

This section describes the configuration steps that the SI must follow to make the MSA solution fully
functional.

2.3.1 HPSA configuration

MSA include some modules than need to be included into the HPSA configuration. A HPSA module is
(from the HPSA Overview document):

“Modules are used for all functions which interface the workflow manager to its environment, like
synchronizing with external sources of input, sending messages and emails, accessing the database,
interacting with the transaction manager to execute activation tasks, etc.”

2.3.1.1 SOSA Module

In order o get a correct communication between HPSA and SOSA is necessary to configure the response
module in $ACTIVATOR_ETC/ config/mwim.xml file.

<Module>
<Name>sosa_async_responser</Name>
<Class-Name>com.hp.spain.engine.module.sosa.SosaAsyncResponserimpl</Class-Name>
<Param name="errors_async_persistence_file" value="$ACTIVATOR_VAR/tmp/errors_async_responser.dat"/>
<Param name="write_in_queue" value="false"/>
<Param name="sosa_async_queue" value="sosa_async_queve"/>
</Module>

Don't forget to replace the $ACTIVATOR_VAR with the correct installation path.
To apply this change is necessary to reload the HPSA configuration for the HPSA user interface.

2.3.1.2 WSC Module

To enable the WSC module is necessary declare it in the mwfm.xml file. This is the minimal configuration
that must be set for this module.

<Module>
<Name>wsc</Name>
<Class-Name>com.hp.ov.activator.mwfm.engine.module.wsc. WSCModule</Class-Name>
<Param name="database_module" value="db"/>

</Module>

12
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Note: the value for the database_module must exist in the mwfm.xml configuration. By default this module

exists on HPSA.

Some additional parameter could be configured for this module. Next table show the allowed
configuration the WSC module.

Parameter

Required

Description

Reconfigurable

Default

database_module

Yes

The name of the database
module to use in order to

retrieve WSC service and
endpoint definitions.

Yes

none

queve_class

No

This can be set to the
com.hp.ov.activator. mwfm
.module.WeightedEngine
Quevue,
com.hp.ov.activator.mwfm
.module.SimpleEngineQue
ue, or
com.hp.ov.activator.mwfm
.module.PriorityEngineQue
ve.

The
WeightedEngineQueue
use the PRIORITY case-
packet variable in a
weighted way to prioritize
the items on which the
activation threads operate.
ltems that have the same
priority will be processed
in FIFO order.

The SimpleEngineQueue
will not do any
prioritization of activation
requests. They will be
processed in FIFO order.

The PriorityEngineQueue
uses the PRIORITY case-
packet variable to
prioritize the items on
which the activation
threads operate. ltems that
have the same priority
value will be processed in
FIFO order.

com.hp.ov.activato
r.mwfm.engine.mo
dule.WeightedEng
ineQueue

queue_name

The name of the queue the
job will
be waiting in while a

external_request_q
veue

13
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request is being processed

retry_count No Number of times to retry No 3
processing of the external
request.

retry_interval No Interval between each No 10000

retry. Defined in
milliseconds.

min_threads No The minimum number of No 1
threads to maintain for
processing request.

max_threads No The maximum number of No 3
threads to maintain for
processing request.

2.3.1.3 TMPC Module

This module enables workflows to manage a template cache with the information of template data. HPSA
will load this cache when starting the server.

In order to arrange properly, the module must be configured in the Micro-Workflow Manager
(“mwim.xml”). We must set the parameter specified in the following table.

Parameter Required Description Reconfigurable Default
database_module Yes The name of the No None
database module to
use in order to
retrieve template
information.

The way we configure this module in the mwfm.xml is adding the following code snippet into mwfm.xml in
order to enable the new feature.

<Module>
<Name>TMPCModule</Name>
<Class-Name>com.hp.ov.activator.mwfm.engine.module.tmpc. TMPCModule</Class-Name>
<Param name="database_module" value="db"/>

</Module>

2.3.1.4 SmartBean Search Module

This module must be configured in order to access cached bean information from workflows, including the
ones shipped with the MSA solution. This configuration is done in the mwfm.xml file.

<Module>
<Name>SmartBeanSearch</Name>
<Class-Name>com.hp.ov.activator.mwfm.engine.module.sbsm.SmartBeanSearchModule</Class-Name>
<Param name="database_module" value="db"/>

</Module>

This module recognizes the following configuration parameters:

Parameter Required Description Reconfigurable Default
database_mod | Yes Database module used in Yes None
ule order to load the
configuration from database.

14
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2.3.1.5 CORBA Module

To enable the CORBA module is necessary declare it in the mwim.xml file.

<Module>

<Name>corba_module</Name>
<Class-Name>com.hp.ov.activator.mwfm.engine.module.corba.CorbaModule</Class-Name>
<Param name="dynamic_loading_folder" value="$ ACTIVATOR_ETC/config /corba/descriptors" />
<Param name="pool_systems" value="$ACTIVATOR_ETC/config /corba/ems-pool.xml" />
<Param name="max_threads" value="10"/>

<Param name="min_threads" value="2"/>

<Param name="retry_count" valve="1"/>

<Param name="database_module" value="db"/>

<Param name="technology_adapter" value="IOR"/>

<Param name="retry_interval" value="20"/>

<Param name="connection_timeout" value="3600000"/>

<Param name="timeout" value="30000"/>

</Module>

It is also necessary to configure $JBOSS_HOME/standalone/deployments/hpsa.ear/METAINF/boss-

deployment-structure.xml.

<dependencies>
<module name="org.omg.api" services="export" />
<module name="org.jacorb" services="export" />
</dependencies>

2.3.2 SOSA Configuration

2.3.2.1 NGWS protocol adapter

In order fo receive requests via web service interface it is necessary to configure the NGWS protocol
adapter in SOSA. Add the following block in configuration file $SOSA_CONF/sosa_conf.xml, inside the

<ProtocolAdapters> element.

<ProtocolAdapter className="com.hp.sosa.modules.sosamodule.protocoladapters.ngws. NGWSProtocolAdapter"
name="NGWS_PA">

<Paramefer name="ngws.host" value="127.0.0.1"/>

<Parameter name="ngws.port" valve="8071"/>

<Parameter name="ngws.min.threads" value="2"/>

<Parameter name="ngws.max.threads" value="10"/>

<Parameter name="ngws.path" value="ngws"/>
</ProtocolAdapter>

This protocol adapter must be started (users can start/pause protocol adapters using web interface of
Solution Container. Besides, the SOSA queues can be blocked after installation, and it’s necessary unlock
them to process requests).

Note: to make this webservice accessible from any other server, you should configure the parameter
ngws.host with the value 0.0.0.0. Otherwise is going to be accessible only from the local server.

If you have just performed a new installation, you may have to configure the username and password to
connect to MWFM. This configuration must be done in the same file, in MWFM Service Action Executor
section.
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<ServiceActionExecutor name="MWFM_SA_EXECUTOR"

className="com.hp.sosa.modules.sosamodule.executors.mwfm.MwfmServiceActionExecutor" max_parallelism="0">
<Parameter name="host" value="127.0.0.1"/>
<Parameter name="port" value="2000"/>
<Parameter name="user" value="username"/>
<Parameter name="password" valve="password"/>
<Parameter name="async_interval" value="60" />
<Parameter name="launch_retries" value="1" />
<Parameter name="copy_cp_to_output" value="false" />
<Parameter name="timeout" value="90000" />
<Parameter name="timeout_interval" value="30000" />

</ServiceActionExecutor>

Please note that the password must be encrypted, this can be achieved with the crypt utility shipped with
HPSA.

Finally the jetty.start parameter must be set. This parameter is located in $SOSA_CONF/sosa.xml file.

| <Parameter name="jefty.start" value="true" />

2.3.2.2 Bulk protocol adapter

In order to use the bulk activations feature it is necessary to configure the bulk protocol adapter in SOSA.
Add the following block in configuration file $SOSA_CONF/sosa_conf.xml, inside the
<ProtocolAdapters> element.

<ProtocolAdapter className="com.hp.ov.activator.mobile.sosa.protocoladapters.bulk.BulkProtocolAdapter" name="BULK_PA">
<Parameter name="db.pool.name" value="db_sosa_catalog"/>

<Parameter name="bulk.archive.directory" value="/path/to/bulk/archive"/>
<Parameter name="bulk.request.directory" value="/path/to/bulk/requests" />
<Parameter name="bulk.result.directory" value="/path/to/bulk/results" />

<Parameter name="bulk.default.username" valve="ftpuser"/>

<Parameter name="bulk.mail.from" value="sosa@yourcompany.com"/>
<Parameter name="bulk.mail.server.authenticate" value="true"/>

<Parameter name="bulk.mail.server.hostname" value="mail.yourcompany.com"/>
<Parameter name="bulk.mail.server.password" valve="secret"/>

<Parameter name="bulk.mail.server.port" valve="25"/>

<Parameter name="bulk.mail.server.secure" value="false"/>

<Parameter name="bulk.mail.server.username" valve="smtpuser"/>

<Parameter name="bulk.mail.subject" value="Bulk Activations Report"/>

<!- Fine tuning

<Parameter name="bulk.disable.persistence.for.services" value="MCA,SDP,PTT" />
<Parameter name="bulk.enable.persistence.for.services" value="MNP,HLR" />
<Parameter name="bulk.max.attachment.size" value="20971520"/>
<Parameter name="bulk.monitor.interval" value="5000"/>
<Parameter name="bulk.override.persistence" valve="false"/>
<Parameter name="bulk.so.timeout" value="60000"/>

>

</ProtocolAdapter>

This protocol adapter must be started (users can start/pause protocol adapters using web interface of
Solution Container).
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2.3.3 Report Module Datasource Configuration

In order to use the Report Module it is necessary to take info account some configuration issues that are
explained in this section.

Report Module can be configured to work with:
The EP database. In the first case, it is possible:
o to use the uiDB datasource that is already configured for SC applications, or
o to create a new datasource for any of the following reasons:
* To use different connection parameters
= To ensure a certain number of connections
A different database, meaning that it will be necessary to configure a new datasource.

For more information about JBoss datasource configuration:
https://community.jboss.org/wiki/DataSourceConfigurationinAS7#Defining _the DataSource itself

In any case, a datasource alias must be added in order to specify what datasource RM will use.
Datasource alias configuration is defined in the

$JBOSS_HOME//standalone/deployments/hpsa.ear/ep.war/WEB-INF/alias.xml file.
The following examples show what to add to the alias.xml file in the cases previously described:

1. If uiDB is used:

<alias>
<datasource-name>hpsa/jdbc/uiDB</datasource-name>
<datasource-alias>reportmodule</datasource-alias>
</alias>

2. Otherwise, if an external datasource (e.g. rmds) has been created:

<alias>
<datasource-name>hpsa/jdbc/rmds</datasource-name>
<datasource-alias>reportmodule</datasource-alias>
</alias>

2.4 Uninstall MSA

In order to undeploy the MSA solution, follow the steps below:

1. Ensure that HPSA is not running, otherwise stop it now. For more information on stopping and
starting the HPSA service, refer to section “Starting and Stopping Service Activator” in the
HPSA Installation Guide.

Run the deployment manager from the $ACTIVATOR_OPT/bin directory.

Click on System Database Connection and enter database credentials, then click OK.
Click on Local Deployment.

Click on Undeploy Local Solution.

Select the MSA Solution.

A

Click on Undeploy solution.
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2.5 Upgrade MSA

In order to upgrade the MSA solution after upgrade HPSA 6.x to HPSA 7.0.0 follow the steps below:

1.

VO ® N o U0k~ LN

o

11.
12.

13

17.
18.

Ensure that HPSA is not running, otherwise stop it now. For more information on stopping and
starting the HPSA service, refer to section “Starting and Stopping Service Activator” in the
HPSA Installation Guide.

Run the deployment manager from the $ACTIVATOR_OPT/bin directory.

Click on System Database Connection and enter database credentials, then click OK.
Click on Local Deployment.

Click on Undeploy Local Solution.

Select the MSA Solution.

Check Do not undeploy SQL.

Click on Undeploy solution.

Click on Delete Local Solution.

. Copy the new (release for 7.0.0) provided MSA..zip file into the

$ACTIVATOR_OPT/SolutionPacks directory.
Click on Import Solution.

Select from zip/tar file and browse for SolutionPacks/MSA.zip.

. Click on Import.
14.
15.
16.

Click on Deploy Local Solution.
Select the MSA Solution.

Select the appropriate deployment file depending on the version, the database and the operating
system (see the table below).

Deployment file HPS.A Database Operating Test

version System
deploy_upgrade_6_x_to_7_0_0.xml 7.0.0 | Any Windows Any
deployUnix_upgrade_6_x_to_7_0_0.xml 7.0.0 | Any Unix Any

Check Do not deploy SQL.

Click on Deploy solution.

Upgrade of the solution is now complete but additional configuration steps are required. Please review
the Configuration section for more information in order to ensure that your configuration is aligned with
the current environment.

18



HP Mobile Subscriber Activation Solution Pack v7.0.0 - Delivery Guide

3 Customizing the solution

In this section are described a set of use cases that should be used by a System integrator to get
familiarize with the solution and understand the principles need to use and customize this solution.

Use Case 1: Add a new service

3.1

Use case description: “The customer needs to activate a new service (Voice Mail) in his solution. The
target manufacturer where the service needs fo be activated is ZTE.”

3.1.1 Use case analysis

Note: For this use case it supposed that the customer only want to have the operation Create Subscriber
on the voice mail platform.

First step to do the analysis, is get the parameters that the customer want use to invoke the create
subscriber operation. For this case it supposed that only is going to define the phone number and a mail
address of user.

Next step of the analysis is study the target interface, to check the operation supported by the target and
the parameters needed for each operation.

The required steps to develop this service in the application are:

1. Define the northbound interface

2. Create the target adaptor to establish the connection with target
3. Develop the activation workflow
4

Define the error management

3.1.2 Step 1: Define the Northbound interface

The northbound interface definition must be done on the SOSA web interface. The first step is defining the
name of the service action (SA) in the catalog. For this case the name is VOICEMAIL-MOBILE-CREATE.
The next picture shows how to create a new service action in the SOSA catalog.

» SNMP Tool 2 Administrator

» Users

» File | » Search

» Configuration Management

» Roles
» Teams

» Applications

» Inventory views
» Filters

» Stored searches

»
5
» _
»

» Audited actions

New Service Action

» SA Name:*

» Operation:*
» Workflow Name:*
» Extra Info.:

» State:

» Retry Interval:

» Timeout=

enable
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» Report Module
» ECP

» Sosa3

» Snmp Administration
» WSC

# Service Name:*

» | » Protocal Adapter
» | » Queue
» | » Manager

» Senice Action Executor
» Catalog

» Time Window Module

» Global Map

» History

» Performance

» TPS

» |» Senice Orders
» |» Senice Actions

» lic -

»
» |» Add
» Reload » List

# End Action Class:

» Queue Parameters:
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Once the SA has been create is necessary define the parameters associated with the create subscriber
operation.

Is highly recommendable defined in the northbound interface all the possible parameters that target
support, is this way the service definition can be manage easily and on the runtime.

From the target specification it can be obtain the list of parameters that are configurable for the create
subscriber operation. This is the list of parameters for the create subscriber operation as well as it format.

Name Type Format Mandatory Default Value
MSISDN String {1,25} Yes
SERVICECLASS String A1, 5} No 1
LANGUAGE String A1, 5} No 1
PASSWORD String 1,6} No 8888
ENTRYAUTHEN String A1, 5} No 1
MESSAGENOTIFY String [O]T][O]1][O] 1] | No 100
USERNAME String {1, 50} No
EMAIL String *_A-Za-z0-9- Yes

1+(\.[_A-Za-z0-

9-]+)*@[A-Zo-

z0-9]+(\.[A-Zo-

z0-9]+)*(\.[A-

Za-z]{2,})$
ZIPCODE String {1, 15} No
IDNUMBER String A1, 30} No
MWNTYPE String [0]1]2]3]4] No 0
MWNDEST String {1, 25} No
LDOPERATORCODE String {1, 10} No

This parameter must to be defined as service parameters in SOSA catalog. See an example in the next
picture.

e » Search | » SNMP Tool  » Configuration Management = » Administrator | » Inventory | » Hel

Service Action Information:

» SA 0. G

» SA Name: MOBILE
VGICEMAIL
CREATE
MOBILE_VOICEMAIL_CREA...  » Mo,

Service Parameters

Name Type Format Default Value Mandatory Overwrite Enabled Delete
MSISDN String - Reguir expression| 11.25) © r =] |[[x
SERVICECLASS Sting - Rogiar expressonl {151 1 ~ r =] [ Tx
LANGUAGE Stiing - - son 115} 1 r r Fl [
PASSWORD Sting - e I 8883 r r F] >
ENTRYAUTHEN Sting - - sion| (151 1 r r ®] [ [x
MESSAGENOTIFY || Sting - Reguiar expression| DO 100 ~ r =] [ Tx
USERNAVE Sting - - <on-£150) r r F] [x
EMAIL Sting - Resuir exoression| LA Z8-20-8 1+ AZa2091°E] r r &>
ZIPCODE Stiing - Regui (1.1} r r w [x
IDNUMBER String - Fre {1.30} C u o i
MWNTYPE Sting - - o[[213] 0 r r F] [x
MWNDEST Sting - —— (1.25) F r d | B
LDOPERATORCODE | String - Resular expression | {110} r r w [x

Add

For each parameter it can be define a regular expression to validate the parameter value. If the
parameter does not match with this regular expression an error will be returned in the northbound
invocation.
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Additionally it can be define a default value for each parameters, in this use case it have been defined
some default values for some parameters.

3.1.3 Step 2: Create the target adaptor

The selected service need to be activated via webservice. For this reason the target adaptor must be done
using the Webservice Connectivity Module (WSC). In the section 6 of this guide it can be found more
information about this module.

To create the target adaptor is necessary to follow the next steps:

1. Create the new webservice (VoiceMail) using the user interface.

Import the webservice wsdl (See the wsdl in the appendix)

Generate the descriptor using the user interface

Edit the generated descriptor and set an alias for the fields MSISDN and EMAIL

Activate the service

S T

Reload the configuration from the HPSA web interface to load the new webservice into the
module

After these step the service is ready to be used from the activation workflow.

3.1.4 Step 3: Create a new endpoint

Go to the inventory tree view to create a new target under the SoapServer branch, and create a new

& HP Service Activator Inventory - Windows In
Inventory Class Views  Instance Views
MSA/ResourceModel % Create NE %
E &) Regions -
B ¢¥ north Create New MSA_NetworkElementCustom
l B @& Network: Networkl
B & pstam Name Value Description |
B D HeR Networkid Network1 Network the NE belongs to
HSS
Eo p— [ i E—
0O ) HttpServer
08 v T B r——
o Pe Location * Location 2 + Location of the device
o B E— e ——
3 oopbac rimary IP address of the device
B 5 ne ew Role bceman
0og* @l Create NE fi5y Management IP I:l IP address for management of the device: E
[ 50 networkElement: MCA Eavzagelmem . R ———
BB NetworkElement: SM fotocos
[ 88 networkElement: DM PiPolicyEnabled True if this NE use a password policy to authenticate
[ I NetworkElement: TV PWPoiicy - Name of the password policy
South
O ¢ sou UsernameEnabled True if username is used to authenticate management connection
== | e —
— ] T ———
Vendor ~  Vendor of device
0SVersion - 08 version of device
Elemen{Type - Type of device
e R L ——
Role SoapServer NetworkElement Role.
AdminState Up - Up, Down, Unknown, Reserved
LifeCycleState - NetworkElement Status. @

Once the target has been created, right click on the target name and create a new endpoint:
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Class Views  Instance Views

MSA/ResourceModel % Create Endpoint %
[ & Regions
B ¢ North Create New WSCEndpoint
E £ Network: Networkt
I B & psiam Name Value Description I
B D HR TargetEquipment * l:l Name of the target equipment
E & Hss
[ ] [E——
O ) Httpserver
E & Nevanager Po— ] Pasenord o auteniton
PE
) SoapServer
=F e C A —
+ View NE
0 §° endr KeyPwd The key passwiord for authentication
8 network] 2 EENE
@ 58 e X ot e o R s
[ @ networkElement: TV
O § soun cerificate: Security certficate for authentication
ou
PE— C S —
Tmeos v ] Tamout n mtssconds
WscServiceid * voicemail ~ The service this endpoint implements
NetworkElementid = 107 The network element this endpoint belongs to

Those are the field that the user must fill to create an endpoint:
TargetTarget, unique name to identify the endpoint, set VOICEMAIL as target target
UserName: Username for authentication, this field is not mandatory leave it empty.
Password: Password for authentication, this field is not mandatory leave it empty.
Description: Description set by the user, this field is not mandatory leave it empty.
Keystore: Key store for authentication, this field is not mandatory leave it empty.
KeyPwd : The key password for authentication , this field is not mandatory leave it empty.
Proxy: Proxy address, this field is not mandatory leave it empty.
ProxyPort: Proxy port, this field is not mandatory leave it empty.

Certificate: SSL Certificate, this field is not mandatory leave it empty.

Url: Url where the target server is listening, set http://localhost:8088/mocklvmsbossHitpBinding
for this field.

KeyStoragePwd: KeyStore password, this field is not mandatory leave it empty.
Timeout: Timeout for the request in milliseconds, this field is not mandatory leave it empty.
WscServiceld : Relation with the service used by this endpoint, select voicelmail.

NetworkElementld: Relation with the target, this field is read only.

3.1.5 Step 4: Develop the activation workflow

To develop the activation workflow you should use the Workflow Designer Application, this application is
included in the HP Service Activator installer.

It is highly recommended see the Workflow.pdf document (included in the HPSA core documentation) to
get familiarized with the workflow development.

The main steps for this workflow are:
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Get the MSISDN value from the S_INPUT hashmap, this hashmap contains all the parameters
defined for this service in the Service Catalog. The keys of this hashmap are the parameter names
and the values of the hashmap are the parameter values.

Query the platform where the service will be activate, this query should be done using the node
com.hp.ov.activator.mwfm.component.sbsm.SBSGetBeanWithPatternNode. This node searches
the information in the cache to avoid access to the database.

Invoke the Webservice Connectivity Module using the node
com.hp.ov.activator.mwfm.component.wsc. WSCRequestNode, this node receive as an input the
S_INPUT hashmap. These are the parameter declared for this invocation:

<Name>Call WS</Name>

<Action>
<Class-Name>com.hp.ov.activator.mwfm.component.wsc. WSCRequestNode</Class-Name>
<Param name="exec_time" value="constant:invocation_time"/>
<Param name="input_attr_map" value="S_INPUT"/>
<Param name="method_name" value="constant:createUser" />
<Param name="module" value="wsc_module_name"/>
<Param name="request_trace" value="COMMAND_SENT"/>
<Param name="response_trace" value="NE_OUTPUT"/>
<Param name="service_name" value="constant:voicemail"/>
<Param name="target_target" value="beanEndpoint.Targettarget" />
<Param name="throw_excep" value="false"/>
<Param name="input_attr_name0" value="operID"/>
<Param name="input_attr_value0" value="Targetuser"/>
<Param name="output_attr_nameQ" value="response"/>
<Param name="output_attr_value0Q" value="error_code"/>
<Param name="input_attr_name1" value="operPwd"/>
<Param name="input_attr_value1" value="Targetpassword"/>

</Action>

<Next-Node>Switch</Next-Node>
Evaluate the response of this node.
Fill the response hashmap S_OUTPUT, with the values returned by the target.

Control the potential errors of the workflow and invoke the error management module in error
case, to translate the error code.

This picture represents the workflow that need to be developed:
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Je—{ Ik to error ——#{ Map Input Common Yalues J—#] Query platform to activate || [uery endpoint

Find error_fi

false.

*"Easel
Check Eror Acion assign error _deserption External lafform unreathable Suitch

Assing Unexpected error Assign NE_CODE = serror_code

dafedlt

f———— Error in web service connectivity module J———————{ ret_value=1 &

Finish KO unexpected

default

casel

casel
L {inwalid command fFor webservice moduls ——————— ret_valus=2

Firich Retry

casel

Finish Ignore Error

true
4ussign variables to 5_OLTPUT Finish O "r

Once that workflow have been developed should be deployed using the Workflow designer, after the
deployment the user need to reload the workflow using the HPSA administrator GUI.

The source code of this workflow can be found in the MSA installer.

3.1.6 Step 5: Define the error management

There are two kinds of errors that can be managed for a service:

e The workflow errors, these are the error managed in the workflow nodes, the code for these
errors are defined by the developer and are hardcoded in the workflow.

e The errors returned the de targets, these are the error that the platform returns, and the codes for
these errors are defined for the manufacturer and should be described in the platform
documentation.

Both of these kinds of errors can be managed for the Error Management module, basically this module do
a translation of an error code in another error code and description defined for the user. The error codes
are defined in the database using an inventory view. Each error is related with a Platform Type, a
Service and an Operation. In case that is not needed to discriminate for any of these fields the user

should set the value to DEFAULT.

Next picture shows the inventory view for the errors defined for the voicemail service:

€& HP Service Activator Inventory - Windows Internet Explore EE

Instance Views

MSA/ParameterModel 4

B ) Parameters
View MSA_ErrorManagement

[ () Regions
B 3 vendors
B & Configurations Name Value Description
B ) Errors [Piatform Type * liZTE | [Name of the platform type.
B eva Servics * | [VOICEMAL |
[ & GEMALTO DEFAULT Operation identifier
E]. s NE Code * [ 11 Network Element Return Code
= —— The error code that shoukd be returned to
815 zte the northbound interface
B &5 mea Return mailbox number is not  Description that shouid be returned to the
[ £ voICEMAIL Description *  provided northoound interface
B ) oEFAULT Selected Acton perypn The action to b executed

B B1ito100f14 Number of
[0 @ Internal code: 1 - Return code: 1 ol

Timeout Timeout
[0 € 1nternal code: 10 - Return code: 10

Number of retries.

IFthe error was caused because the

[0 @ internal code: 11 - Return code: 11 Number exists  false e e
[0 @ internal code: 12 - Return code: 12 Number not o IFthe error was caused because the
exists number does not exist

[0 @ internal code: 13 - Return code: 13
[0 @ internal code: 14 - Return code: 14
[ @° Internal code: 15 - Return code: 15
[0 € 1nternal code: 16 - Return code: 16
[ @ 1nternal code: 4 - Return code: 4

[0 @ 1nternal code: 5 - Return code: 5

8@ @ay

[ 2 DEFAULT

24



HP Mobile Subscriber Activation Solution Pack v7.0.0 - Delivery Guide

3.1.7 Step 6: Test the service

Atter follow of these steps the service is ready to be tested. If there is a ZTE platform available to test the
service this could be used, if the platform is not available it can be used any software to simulated the
target like SoapUi or similar.

Also could be used a software like SoapUl to send the input request. This is an example of request that
could be used on Soap Ul to test the voice mail service.

<soapenv:Envelope xmlins:soapenv="http://schemas.xmlsoap.org/soap/envelope/"
xmlns:ngws="http://www.hp.com/sosa/protocoladapter/ngws"
xmlns:dyn="http://www.hp.com/sosa/dynamicserviceorder">
<soapenv:Header/>
<soapenv:Body>
<ngws:startDynamicOrderSync>
<dyn:serviceRequest>
<dyn:services>
<dyn:service>
<dyn:name>VOICEMAIL</dyn:name>
<dyn:type>MOBILE</dyn:type>
<dyn:action>CREATE</dyn:action>
<dyn:characteristics>
<dyn:characteristic>
<dyn:name>MSISDN</dyn:name>
<dyn:value>1</dyn:value>
</dyn:characteristic>
<dyn:characteristic>
<dyn:name>SERVICECLASS</dyn:name>
<dyn:value>2</dyn:value>
</dyn:characteristic>
<dyn:characteristic>
<dyn:name>LANGUAGE</dyn:name>
<dyn:value>3</dyn:value>
</dyn:characteristic>
<dyn:characteristic>
<dyn:name>PASSWORD</dyn:name>
<dyn:value>4</dyn:value>
</dyn:characteristic>
<dyn:characteristic>
<dyn:name>ENTRYAUTHEN</dyn:name>
<dyn:value>5</dyn:value>
</dyn:characteristic>
<dyn:characteristic>
<dyn:name>MESSAGENOTIFY</dyn:name>
<dyn:value>101</dyn:value>
</dyn:characteristic>
<dyn:characteristic>
<dyn:name>USERNAME</dyn:name>
<dyn:value>7</dyn:value>
</dyn:characteristic>
<dyn:characteristic>
<dyn:name>EMAIL</dyn:name>
<dyn:value>foo@bar.baz</dyn:value>
</dyn:characteristic>
<dyn:characteristic>
<dyn:name>ZIPCODE</dyn:name>
<dyn:value>9</dyn:value>
</dyn:characteristic>
<dyn:characteristic>
<dyn:name>IDNUMBER</dyn:name>
<dyn:value>10</dyn:value>
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</dyn:characteristic>

<dyn:characteristic>
<dyn:name>MWNTYPE</dyn:name>
<dyn:value>3</dyn:value>

</dyn:characteristic>

<dyn:characteristic>
<dyn:name>MWNDEST</dyn:name>
<dyn:value>12</dyn:value>

</dyn:characteristic>

<dyn:characteristic>
<dyn:name>LDOPERATORCODE</dyn:name>
<dyn:value>13</dyn:valve>

</dyn:characteristic>

</dyn:characteristics>
</dyn:service>
</dyn:services>
</dyn:serviceRequest>
<ngws:user>foobar</ngws:user>
</ngws:startDynamicOrderSync>
</soapenv:Body>
</soapenv:Envelope>

3.2 Use Case 2: Customize the northbound interface

Use case description: “The customer needs to fix a default value for the parameter LDOPERATORCODE in
the service Voice Mail.”

3.2.1 Use case analysis

The first step for the analysis is defined the value that the customer want to set for the parameter
LDOPERATORCODE, for this example we supposed that the value is 5.

Next step is determine if this parameter will be received in north bound interface and if this parameter
should be overwrite with value received from the northbound interface or not. For this example we
supposed that the value could not be overwrite, this mean that for this service the value that is going to be
send to the target will be 5.

The required steps to implement this customization are:
1. Edit the service parameters

2. Test the service

3.2.2 Step 1: Edit the service parameters

To edit the service parameter for the service VoiceMail Create is necessary go to the Service Catalog and
look for the service Mobile VoiceMail Create.
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» File | » Search | » SNMP Tool | » Configuration Management | » Administrator | » Inventary | » Help
» Service Action Search

» SA Name » Senice Name » Operation » Workflow Name » Work Queue » State
[MOBILE | |VOICEMAIL | [CREATE | | | | | -

Service Actions found

Use SA Undo Subqueue Error Retries End Manual

SA SA  Service 4 5 Extra Work . MNo.of Retry Mapper . Subqueue ! . Queue

I Name Mama Operation unique  Workflow Name  Worklow (% o ' State Offline p o0 "o FEPPY! Timeout oo 2ls  Assign  Codes by Em. Action Op.on  ou®
name Name Class  Retry Code Class Eror

679 MOBILE VOICEMAIL CREATE true MOBILE_VOICEMAIL_CREATE basic enable false 0 ] 00 Tfalse

Found one record. Page 1
Export: CSV | Excel| XhL

Then in necessary open the parameter definition for this service:

» File | » Search  » SNMP Tool | » Configuration Management | » Administrator | » Inventory | » Help

Service Action Information:
 SAId 679

» SA Name: MOBILE » Extra Info. » Mapper Class:
VOICEMAIL » Work Queue: basic 00

» Operat CREATE » State: enable false.

» Workflow Hame: MOBILE_VOICEMAIL_CREA, » No. of Refries 0 false

» Undo Waorlfiow Name: » Retry Interval 0

» Actions
» Senvice action » Edit
» Parameters » | » Save

» Mappings o | » Edit Parameters
= |»EditMappings
» Delete

Now we are going to set the value 5 for the field LDOPERATORCODE and check the column overwrite to
indicate that the default value takes precedence over the request value. Be sure that the column enabled

is check to indicate that the field is enabled and the mandatory column is unchecked to indicate that this

field is not mandatory in the northbound interface.

» SNMP To Configuration Management | » Administrator | »

Service Action Information:
» SAId: &9

» SA Hame: MOBILE » Extra Info, » Mapper Class: » Retries by Er. Code:
» Service Name: VOICEMAIL » Work Queue: basic » Timeout 00 » End Action Class

» Operation CREATE » State: enable » Subqueue Parameter » Manual Op. on Error. false
» Workflow Name: WOBILE_VOICEMAIL_CREA. » No. of Retries: 0 » Subgqueue Assign Class: » Offline: false
» Undo Workflow Hame: » Retry Interval 0 » Error Codes Retry: » Queue Parameters:

» Actions

Name Type Format Default Value Mandatory Overwrite Enabled Delete
sung - Reqer expreason 11251 \ \ |
String - Regularexprgssiun‘-{"f'} ‘ ‘1 |
Stng - Regulrexression 4151 | [ |
sung - Regulr exression {161 ] fozez ]
shng - Reguir exressin {151 ] f |
String - Regular exaression AIOTIAN] ] 100 |
String - Regularexpressiun‘”-gm ‘ ‘ |
swng - Requir xaression| LAZa-20-91-(LAZa09 1@ [ |
String - Ragu|arexprassmn‘“-15} ‘ ‘ |
sung - Rt cxpresn| 0130 ] \ ]
sing - Roguir cxression 012 \ o |
Sving = Reguir exprasson {1.25) ] [ |
sung -~ Rogularsxpression 110 ] 5 |
Add

After edit the LDOPERATORCODE parameters in necessary save the changes this operation is available
under the Action menu.

The next step is to reload the SOSA catalog to apply these changes in the catalog. The changes will not
be applied until the catalog was reloaded. Next picture show how to reload the SOSA catalog.
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»File | » Search | » SNMP Tool | » Configuration Management [ Rt B
Service Action Information: » Users »
» SAld 679 » Roles »
» SA Name. MOBILE »Extraln ; Toams » Mapper Class: » Retries by Err. Code:
» Service Hame: WOICEMAIL » Work Cy » » Timeout: 0o » End Action Class:
» Operation: CREATE » state: | » Applications 5 # Subqueus Parameter. # Manual Op. on Error: falze
» Warkfiow Nams: MOBILE VOICEMAL CREA.  3No. 0f R, |nuaror i + Subqueue Assign Class: » oine: s
» Undo Workflow Name: » Retry In v » » Error Codes Retry: » Queue Paramet ters
» Filters »
- Stred searches .
» Audited actions »
Service Parameters » Report Module
Name Type Format » ECP 5 Default Value Mandatory Overwrite Enabled Delete
MSISDN String - Regui » S0533 » | » Pratocol Adapter » ~ - ~ *
SERVICECLASS siing - aagy * Snmp Adminitsation » | » Queus N = = = —
» WSC » | » Manager »
LANGUAGE String - Reguiar sxprassion [ 1107 » Senice Action Executor » L L e =
PASSWORD String - Reguiar expression 1.6} » Catalog » | » Serice Orders N r r i *
» Time Window Module » | » Senvice Actions »
ENTRYAUTHEN String - Regular expression| {15} + Globel Map LS r r ~ x
MESSAGENOTIFY String - Reguiar expression | [01110/1110]T] » History » r - v *
USERNAME String - Reguar expression | 4150} ? ::g”’””” r - [ x
» »
EMAIL String - Regular expression| |LA-Z320-91+(\.[ A-Za-20 Ty r - v ¥
ZIPCODE String - Regular expression [{1.15} u u o X
IDNUMBER Siring - Reguiar expression {1.30} L L o X
MWNTYPE Stiing - Regular expression [0111213}4] u . L i
MWNDEST String - Reguiar expression [ 11:25) r r I x
LDOPERATORCODE | String - Reguiar expression 110} 5 r ~ ~ *

Add

3.2.3 Step 2: Test the service

To test the service, is necessary send the next set of requests and do the make the appropriate checks:

1. Send a request including the parameter LDOPERATORCODE with the value 8 and check that the

value sent to the target is 5.

2. Send a request without include the parameter LIDOOPERATORCODE and check that the value
sent fo the target is also 5.

For this example could be use the same request that we used in the use case 1 of this document.

3.3 Use Case 3: Customize the command template
Note: The previous examples are for service whose activation is based on webservice, this example is
based on a service whose activation is base in CLI (Command Line Interface).

Use case description: “The customer wants to add a new parameter (IDTEST) in the command to activate
a subscription in the HIR.”

We supposed that this new parameter IDTEST is supported for the target, and that the activation is going
to be performed over an EMA platform.

3.3.1 Use case analysis

First step is study how we want to manage this parameter:
e Is mandatory? It supposed that the parameter is mandatory for this service.

e Which are the possible values supported for this parameters? It supposed that the possible values
are Oor 1.

e Does the customer want to fix a default valued for the parameter? It supposed that the customer
want to fix the value 1 for it.

e Will this parameter be received in the northbound interface? It supposed that this parameter is not
going to be received in the northbound interface.
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As the parameter is not going to be received in the northbound interface, it must be declared in the
command template.

Next step is to establish the command syntax, to do that is necessary to get the information from the target
manufacturer. For this example it supposed that the syntax of the command including the new parameter
is the next one:

CREATE:HLRSUB:MSISDN, <value>: IMSI, <value>:IDTEST, <value>: PROFILE,<value>:

TRANSID, <value>: CAW, <value>: CAT,<value>: STYPE,<value>: CSP,<value>: OB, <value>:
OBO, <value>: OSB1,<value>: OSB2,<value>: OSB3, <value>: OSB4,<value>: OBR,<value>:
NAM, <value>: PDPCP,<value>: RSA,<value>: SCHAR,<value>: HOLD, <value>: MPTY,<value>:
AMSISDN, <value>: CLIP,<value>: CLIR,<value>: COLR,<value>: COLP,<value>: SOCLIR, <value>:
SOCLIP,<value>: SOCOLP,<value>: CFU, <value>: DCF,<value>: CFNRY, <value>: CFNRC,<value>:
CFB,<value>: DBSG, <value>: OFA,<value>: BAIC,<value>: BAOC, <value>: PRBT,<value>:
BEARER_SERVICES, <value>: TELESERVICES;

The last step is to identify the manufacturer, element type and OS version of the target where the customer
wants to do the modification. It supposed that the manufacturer is Ericsson, the element type is APG40C

and the OS version is R13
The required steps to implement this customization are:
1. Edit the command template for the service MOBILE HLR CREATE on EMA.

2. Test the service

3.3.2 Step 1: Edit the command template

Go to the command template application in the solution container web interface and search the template
that you want modify. To access the Search (List) page, go to “Administrator -> ECP -> Activation
Commands Template -> Command Routine -> List”

The search page will be displayed, empty for now. At the top-most part you will find the fields you can
use to filter your search:

» File

Search Command Routine:

» Search | » SNMP Tool | » Configuration Management | » Administrator  » Inventory  » Help

sName sManufacturer »Element Type »0S Version sRoutine

Select the manufacturer Ericsson, the element type APG40C and OS version R13 and click the button
search.

Once you hit the “Search” button, the results will be listed. Now click on the MOBILE_HLR_CREATE to go
to the Edition page.

After click on this element you can see a preview of the command template. To ed

it the template click on Edit option under Actions menu. The next picture shows the edition screen.
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Search | » SNMP Tool | » Configuration Management | » Administrator | » Inventory  » Hel

Template information:

» Name * MOBILE_HLR_CREATE » Manufacturer* Ericsson ~ s Element Type* APG40C v »0S Version* R13

» Description Create for HLR » Commeon Cenfig EMAEricssonCommonConfic +

E [ﬁiﬁ i » Edit area

W ,(H CREATE :HLRSUB:MSISDN, $ {MSISON]:IMSI, $ [ IMSI}$PROFILESTRANSID$CANSCATSSTYPESCSPS0BI$0BOS0! $05B250: $05B4 e
DO: 5 PDPCP5RSA% SCHARSHOLDSMPTY5AMST SDNSCLI PSCLIR$COLRSCOLPSSOCLIRS SOCLI PE SOCOLPSCFUSDCF§ CFNRY 5 CFNRCSCFBS DBSGSOFASBATICSBAOCS PRETSBEARER SERVICE Ej

o Section 0 —— I F | S TEIESERVICES:

[TEMPLATE: NoEcho]

UNDO:

» Preview

Select the Section O in the left tree and edit the command, this is the new command that need to be
appears in the section O:

CREATE:HLRSUB:MSISDN, ${MSISDN}:IMSI, ${IMSI}:IDTEST, 1 $PROFILES TRANSID$ CAW$CAT$STYPE$
CSP$OBISOBOSOSB1$OSB2$OSB3$OSB4$OBRSNAMSPDPCPSRSA$SCHARSHOLDSMPTY $AMSISD
NS$CLIP$CLIR$COLR$COLP$SOCLIR$ SOCLIP$SOCOLP$CFUSDCF$CFNRY $CFNRCSCFBSDBSGSOFAS
BAIC$BAOCSPRBT$BEARER_SERVICESSTELESERVICES;

[TEMPLATE:NoEcho]
[TEMPLATE:Pattern "RESP. *:([0-9]+);"]
[TEMPLATE:Variable "CODE"]

The difference with the previous command is that we have include “IDTEST,1: ” that was the objective of
this customization.

To apply the change in the template click Save option in the Action menu. This action will update the
command template into the database.

For the change to take effect in the activation process go to the HPSA Administrator web and click on
Reload configuration, this option in under the Self management menu.

For more information about the Command Template Module, see the section 5 in this document.

For more information about the command syntax see ECP.pdf document, this document is provided with
the Extension Pack installation kit.

3.3.3 Step 2: Test the service

To test the service launch a request for the service MOBILE HLR CREATE, without the parameter IDTEST
and verify that this parameter appears in the command sent to the target.

3.4 Use Case 4: Customize the error management

Use case description: “The customer needs to change the error code and the description returned in the
northbound interface for the error code 10 in the Voice Mail service.”
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3.4.1 Use case analysis

The first step is to identify the error code and the description that the user wants to return in the
northbound interface when the error returned by the VoiceMail platform is 10.

It supposed that the user want to receive and error code 1001 and the description should be “Internal
error on the Voice Mail platform”

The required step to implement this customization is:

1. Edit the Error

3.4.2 Step 1: Edit the error

To edit the error go to Inventory= Open and select Class Views = MSA/Instance Views.

Instance Views
CREModel/Equipment
CRModel/iParameters
CRModelMMMiDataload
MZAFarameteriodel
M=AResourcelodel

Inventory Class Views

MSAParameterModel %,
[=] ) Parameters
[#] ) Regions
E 3 vendors
[E I configurations
E ) Errors

Now go to the Error 10 on the VoiceMail branch, select the error 10 and right click on to get the Edit
option. Click on Edit option to see the Edit form.

Inventory Class Views Instance Views

| wsarparameteriodel o I i cror % |

[ ) Parameters

B © Regions Update MSA_ErrorManagement
E & Vendors
[ 3 Configurations Name Value Description
O & Errors Platform Type * Name of the platform type
E ) EMA -
Service * \VOICEMAIL Target service
[ ) GEMALTO
(o] 2 Hss Operation * Operation identifier
) ZTE
a2 oo [ e
= mMca
B & volcEmaIL Return Code * The error code that should be returned to the northbound interface:
B & perauLT Return Description = |system failure Description that should be returned to the northbound interface
B 1t 100f 14
Selected Action * RETURN ~ The action to be executed

[ @° Internal code: 1 - Returr

[ €° Internal code: 10[ = uymber of Retries
-+, View error

& edit error

Number of retries

(] !ﬂ Internal code: 12
0 @° Internal code: 13| [/ Delete error fmber exits
O gu Internal code: 14 - Retul Humber not exists
[1 €° Internal code: 15 - Retul
[ €° Internal code: 16 - Retul
O gu Internal code: 4 - Returr
O gﬂ Internal code: 5 - Returr
@

[ ) DEFAULT

If the error was caused because the number exists

If the error was caused because the number does not exist

< [T 3
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Now update the field Return Code with the value 1001 and the Return description with the value “Infernal
error on the Voice Mail platform”, and click on OK button to save the information into the database.

Note that after any change in the error management HPSA configuration must be reloaded to get that
changes take effect.

After reload the HPSA configuration the error code and the description returned in the northbound
interface will be the new ones.

3.5 Use Case 5: Create a new report

Use case description: “The customer needs to have a new report with the next requirements:
Input: MSISDN, IMSI, ACTION and Start Date.

Output: MSISDN, IMSI, TYPE, ACTION, S_CODE, S_DESCRIPTION, SOSA_CODE,
SOSA_DESCRIPTION, NE_CODE, NE_DESCRIPTION, COMMAND_RECEIVED, COMMANDS_SENT,
NETWORKELEMENT, CREATION_TIME, NE_ACT_TOTAL_TIME, PROCESSING_TIME, USERNAME,
WEF_INSTANCE, NE_OUTPUT.”

3.5.1 Use case analysis

Note: for this example is necessary to have some knowledge about SQL and the database model.

The analysis of this case consists only in to identify where is the information in the database, for this
example all the information is the in the table history_hbm_sa. This table is the one used in MSA to store
the information for all the activations.

The required steps to implement this customization are:
1. Create the SQL Query
2. Edit the report module configuration file

3. Test the new report

3.5.2 Step 1: Create the SQL query

Write the sql in any sql editor in order to test it. For this example the sqgl that we are going to use is:
SELECT

MSISDN, IMSI, TYPE, ACTION, S_CODE, S_DESCRIPTION, SOSA_CODE, SOSA_DESCRIPTION,
NE_CODE, NE_DESCRIPTION, COMMAND_RECEIVED, COMMANDS_SENT, NETWORKELEMENT,
CREATION_TIME, NE_ACT_TOTAL_TIME, PROCESSING_TIME, USERNAME, WF_INSTANCE,
NE_OUTPUT

FROM

HISTORY_HBM_SA

WHERE
START_TIME > TO_TIMESTAMP ( ?,'DD-MM-YY HH24:MI:SS"))
AND
START_TIME < TO_TIMESTAMP (?,'DD-MM-YY HH24:MI:SS")
AND
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upper(ACTION) = upper(?)

Set correct values for the inputs and test the query.

3.5.3 Step 2: Edit the report module configuration file

Edit the Report Module configuration file $JBOSS\standalone\deployments\hpsa.ear\ep.war\WEB-
INF\classes\reportmodule\ReportModuleQueryDefinition.xml

Add in this file de new query using the format defined for the Report Module. The text does need to be
added in the configuration file is:

<query>
<name>Activations by item</name>
<description>Search History Service Actions by item</description>
<order>100</order>
<maxlengthresult>1000</maxlengthresult>
<sql>
<!|[CDATA[
NE_ACT_TOTAL_TIME,
MSISDN,
IMS,
TYPE,
ACTION,
S_CODE,
S_DESCRIPTION,
SOSA_CODE,
SOSA_DESCRIPTION,
NE_CODE,
NE_DESCRIPTION,
COMMAND_RECEIVED,
COMMANDS_SENT,
NETWORKELEMENT,
CREATION_TIME,
PROCESSING_TIME,
USERNAME,
WEF_INSTANCE,
NE_OUTPUT
FROM
HISTORY_HBM_SA
WHERE
('$From$' is null OR START_TIME > TO_TIMESTAMP ('$From$','DD-MM-YY HH24:MI:SS"))
AND
('$To$' is null OR START_TIME < TO_TIMESTAMP ('$To$','DD-MM-YY HH24:MI:SS"))
AND
('$OPERATIONS' is null OR upper(ACTION) = upper('$OPERATIONS'))

</sql>
<input>
<parameter mandatory="false">
<name>OPERATION</name>
<type>Select</type>
<description>Operation</description>
<defaultValue></defaultValue>
<listOfValues>
<value></value>
<value>CREATE</value>
<value>GET</value>
<value>SET</value>
<value>DELETE</value>
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</listOfValues>
</parameter>
<parameter mandatory="false">
<name>From</name>
<type>datetime</type>
<description>From Date</description>
<defaultValue></defaultValue>
</parameter>
<parameter mandatory="false">
<name>To</name>
<type>datetime</type>
<description>To Date</description>
<defaultValue></defaultValue>
</parameter>
</input>
<redirections>
<redirect>
<jsp>table.jsp</jsp>
<type>Table</type>
</redirect>
</redirections>
</query>

Save the file in the filesystem.

For more information about the Report Module see the section 7 in this document

3.5.4 Step 3: Test the new report

To test the new report, go to the Report Module application in the solution container “Administrator ->
Report Module “

Now the new Report “Activation by ltem” should be appears in the reports list

»File | » Search | » SNMP Tool | » Configuration Management | » Administrator | » Inventary | » Help

» From (datetime) » OPERATION (Select) » Select output format
» Select Query = - Tatle -

Activations by ftem ()

Execute the report clicking on the Search button and verify that the information that appears at the bottom
table is the expected.

3.6 Use Case 6: Combine two services

Use case description: “The customer wants to combine the activation of two services for a single service
request. The services to combine are VoiceMail and MCA (Missed Alert Calls) for the operation create”

34



HP Mobile Subscriber Activation Solution Pack v7.0.0 - Delivery Guide

3.6.1 Use case analysis

The analysis of this case consists on determine which are the parameters needed to activate both services,
the parameters needed will be the summation of the parameter of both services. The next table represents
the parameters needed to activate this new complex service.

Name Type Format Mandatory Default Value
MSISDN String 41,25} Yes
SERVICECLASS String {1, 5} No 1
LANGUAGE String {1, 5} No 1
PASSWORD String 1,6} No 8888
ENTRYAUTHEN String 11, 51 No 1
MESSAGENOTIFY String (01110 1]10] 1] | No 100
USERNAME String {1, 50} No
EMAIL String "N_AZa-z0-9- Yes

J+(\.[_A-Za-z0-

914)*@[A-Za-

20.9]+(\.[A-Za-

20:914)* (\.[A-

Zaz]{2,})$
ZIPCODE String 11, 15} No
IDNUMBER String {1, 30} No
MWNTYPE String [01112]3[4] | No 0
MWNDEST String {1, 25} No
LDOPERATORCODE String {1, 10} No
NOTIFYPHONE String 41,25} No

Also is necessary to determine which will be the execution mode for of this new service request. It
supposed that both services should be activate in serial, executing the Voice Mail first and the MCA in the
second position, and in case of error the action to apply will be continue.

To finish this analysis we will decide the name of this new service, for this example we are going to use:
VAS-MOBILE-CREATE.

The required steps to implement this customization are:
1. Create the new Service Request in the service catalog
2. Test the service

Note: the addition of this new complex service will be on the fly and without affection to the current
services.

3.6.2 Step 1: Create the new service request in the service catalog

To create the new service request in the catalog is necessary to add a new service order in Sosa Catalog.
To execute this action go to Administrator > Sosa3-> Catalog—> Service Order>Add, and fill the fields as
the next picture shows:
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New Service Order

=50 Hame:* VAS  Service Hame:* MOBILE
» Operation= CREATE  Persistables r
» Timeout: 0 » Processing g Mode: serial -

= Stater enable - 30nErront CONTINUE -

= Offines r

In this form we have configured the new service order with the options that we decided in the analysis of
the case.

After save the new service order is necessary to add the services that will compose this service order. To
do this task, right click on the service order that appears in the screen after save the service order and

select the option Add Child.

T

» Bt Childre
» Add Child

After select the option Add Child a list will be appears with all the services that could be added to this
service order.

Execute this step twice, one to add the service Voice Mail and another one to add the service MCA. Then
click on Save operation under Actions menu. Next picture represent the how the new service order should
look like after add the two services:

O 3

MOBILE VOICEMAIL CREATE

Once that service has been attached to the service order and the service order has been saved, to apply
the change and have the new service order ready to be executed, it is necessary to reload the Sosa
catalog.
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» Auited actions
» Report Module

»ECP

» Catalog s
» Time Window Maduls » | » Senice Actions
» Reload

3.6.3 Step 2: Test the service

To test the service order that we have created is necessary to create a new service request, supposing that
we are using the default northbound interface; the request that we need to send to execute this new
service is the next:

<soapenv:Envelope xmlins:soapenv="http://schemas.xmlsoap.org/soap/envelope/"
xmlns:ngws="http://www.hp.com/sosa/protocoladapter/ngws" xmlns:dyn="http://www.hp.com/sosa/dynamicserviceorder'>
<soapenv:Header/>
<soapenv:Body>
<ngws:startDynamicOrderSync>
<dyn:serviceRequest>
<dyn:services>
<dyn:service>
<dyn:name>VOICEMAIL</dyn:name>
<dyn:type>MOBILE</dyn:type>
<dyn:action>CREATE</dyn:action>
<dyn:characteristics>
<dyn:characteristic>
<dyn:name>MSISDN</dyn:name>
<dyn:value>1</dyn:value>
</dyn:characteristic>
<dyn:characteristic>
<dyn:name>SERVICECLASS</dyn:name>
<dyn:value>2</dyn:value>
</dyn:characteristic>
<dyn:characteristic>
<dyn:name>LANGUAGE</dyn:name>
<dyn:value>3</dyn:value>
</dyn:characteristic>
<dyn:characteristic>
<dyn:name>PASSWORD</dyn:name>
<dyn:value>4</dyn:value>
</dyn:characteristic>
<dyn:characteristic>
<dyn:name>ENTRYAUTHEN</dyn:name>
<dyn:value>5</dyn:value>
</dyn:characteristic>
<dyn:characteristic>
<dyn:name>MESSAGENOTIFY</dyn:name>
<dyn:value>101</dyn:valve>
</dyn:characteristic>
<dyn:characteristic>
<dyn:name>USERNAME</dyn:name>
<dyn:value>7</dyn:value>
</dyn:characteristic>
<dyn:characteristic>
<dyn:name>EMAIL</dyn:name>
<dyn:value>foo@bar.baz</dyn:value>
</dyn:characteristic>
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<dyn:characteristic>
<dyn:name>ZIPCODE</dyn:name>
<dyn:value>9</dyn:value>

</dyn:characteristic>

<dyn:characteristic>
<dyn:name>IDNUMBER</dyn:name>
<dyn:value>10</dyn:value>

</dyn:characteristic>

<dyn:characteristic>
<dyn:name>MWNTYPE</dyn:name>
<dyn:value>3</dyn:value>

</dyn:characteristic>

<dyn:characteristic>
<dyn:name>MWNDEST</dyn:name>
<dyn:value>12</dyn:value>

</dyn:characteristic>

<dyn:characteristic>
<dyn:name>LDOPERATORCODE</dyn:name>
<dyn:value>13</dyn:value>

</dyn:characteristic>

<dyn:characteristic>
<dyn:name>NOTIFYPHONE</dyn:name>
<dyn:value>11122233344455</dyn:value>

</dyn:characteristic>

</dyn:characteristics>
</dyn:service>
</dyn:services>
</dyn:serviceRequest>
<ngws:user>foobar</ngws:user>
</ngws:startDynamicOrderSync>
</soapenv:Body>
</soapenv:Envelope>

This request indicate that the service that should be executed in the one identified by VAS- MOBILE-
CREATE, and the parameters to activated this service are the ones that we got in the use case analysis.
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4 High performance architecture

Usually the Mobile Service Provider required a high performance in the activation process, due more of
the mobiles services need to be activated instantly. Additionally the service provider need to manage a
high volume of activation per second, this will depends on the Operator size.

MSA is designed to cover these both aspects of the mobile activation. The mains technical details of this
product to fix these requirements are:

o The MSA workflows do not access to the database during the execution time, all the information
needed by the workflow is query from the memory, using the smart bean search module.

e The interaction with the database is centralized in SOSA, in this way the number of connection
with the database needed is lower and can be done in bulk. The interaction with the database is
only to store the history information.

e For the command line activation, the connection with the target is doing using a connection pool,
this characteristic avoid opening a new connection with the target for each activation request.

o For the webservice activation, the Webservice Connectivity Module provides an efficient
mechanism to send webservice request to the target.

e In the northbound interface SOSA make an efficient load distribution using a queues system as
well as controlling the avalanche.

Next picture shows the processes that need to run MSA:

NBI, Load
Distribution, etc

Solution User Interface
Container

Process workflows

Equipment
connection

All this processes are java process that can run independently hence the process can run in the same or in
a different physical server.
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Next picture show the recommended process distribution using two physical servers:

Server 1 Server 2

Solution
Container

The number of the servers depends on the customer requirements, this architecture can grow horizontally,
and it means that the number of HPSA and ECP can be increasing to increase the performance, in a
lineal way.

For a huge volume of activations, like 500 requests per second the number of servers should be next to 5,
can be supposed that each HPSA+ ECP can support around 100 requests per second. This estimation is
made base on the services offer by MSA out of the box. Next picture shows the recommended
architecture for this use case:

Server 1 Server 2 Server 3 Server 4 Server 5

SOSA

HPSA

ECP

Note: for all this cases, it supposed that the database runs in a different server.
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5 Template management

MSA provides a solution to manage and cache ECP command templates.

A “Command Template” is a string which complies with a certain syntax through which an Operation is
expressed, for the ECP Module to interpret and process it, usually with the purpose of automating a
human interactive session on the Target System. The “Command Template” states the commands needed
to perform the process (and usually to roll it back too), with specific information on every command, such
as possible command outputs and their meaning (error, success) and the control flow which determines
their execution order, among other things.

For more information about ECP and Command Templates see the document ECP.pdf, this document is
available with the Extension Pack installation kit.

The main advantages provided by this module are:

5.1

The templates are stored in the database, this feature provided a centralized management of the
templates, and this is very helpful when MSA is installed on a cluster.

The templates can be managed from a user interface integrated in the Solution Container.

The template are related with the target OS version and Type, this feature allow managing
different version of the target for the same service.

This module provide a cache module and a node to query the template from this cache in the
workflow avoiding to access to the database.

A change in a template can be applied on the fly only and from the user interface.

This module provide a mechanism to export/import a template in an xml file, this feature is very
helpful to migrate a template from the development environment to the production environment.

Managing a template from the user interface

Since the ECP Template Model Web Ul is deployed inside the SC (solutions container), to access it you
have to open the SC in a supported web browser and go to “Administrator -> ECP ->
Activation Commands Template” as shown below:
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/2 Solution Container, - HP - Windows Internet Explorer,
@ Al

Archivo  Edicion  Ver Favoritos  Herramientas  Ayuda

| [
localhost ! o[ &[4[ x| |2

¢ Favoritos | [BJ] Solution Container - HP £~ B = & - Pagina~

»File | » Search  » SNMP Tool | » Configuration Management [Nt caoll » Inventory | » Help

Login information: » Inventory views P
» Filters »

oo » Stored searches »

» Failed attempts: » ECP console ),
» Users »
» Roles »
» Applications »
» Audited actions »
» ECP » |» Pool »
» Sosa3 » |» Subpool »
» Snmp Administration » | » Template »
»SR » | » Common Configuration P

» Activation Commands Template |» Command Routine »
» Template »

This application manages two types of objects, Command Routines and Templates. A command routine is
basically a part of a template. The templates are divided in sections an each section is composed by two
command routine.

Command Routines has three available operations: Search (List), View details and Edit. Templates has the
following available operations: Search (List), Create, View details, Edit and Delete.

For templates, only the Search (List), Import and the Create operations can be accessed from the menus of
the solutions container (see picture below). For accessing to View details, Edit, Export and Delete
operations the user must first use the Search (List) and select an item listed there.

» SNMP Tool | » Coi

Template information:

' Name:

n Config:
» Manufacturer.
» Element T
» 08

For command routines, only the Search (List) operation can be accessed from the menus of the solutions
container (see picture below). For accessing to View details and Edit operations the user must first use the

» Users
» Roles

it 5 Teams

» Applications

» Inventory views
» Filters

» Stored searches
» Audited actions
» Report Module
»ECP

| » Preview

» ECP console

» Common Configuration
» Performance

Search (List) and select an item listed there.
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» Sosad » |» Pool »
B:M515] » Simp Administration » | » Subpool » [rs22,1") sconmnp
» Template »

s 551, {» Activation Commands Template» | » Command Rautine 5 |SCOMMAND
» Instances » Template » | » New
» Dynamic configurations S » Import
» List
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» File | » Search | » SNMP Tool | » Configuration Management [JSIRTISTRERY , inventory
» Inventory views
» Fiters

» Stored searches

» ECP console
» Users
»Roles

/. - -
» Applications
» Audited actions
» ECP » | Pool
» Sosa3 » | » Subpool

» Snmp Administration » |» Template
» SR » |» Common Configuration

»
» Activation Commands Template |» Command Routine » [»List
» Template »

5.1.1 CommandRoutine Operations

5.1.1.1 Search/List

To access the Search (List) page, go to “Administrator -> ECP -> Activation Commands
Template -> Command Routine -> List”

The search page will be displayed, empty for now. At the top-most part you will find the fields you can
use to filter your search:

»File | » Search | » SNMP Tool | » Configuration Management | » Administrator | » Inventory | » Help

Search Command Routine:

»Name »Manufacturer »Element Type »08S Version »Routine

v [ v [ v [ » Search
| .. ——

Note that it is not mandatory to fill any of them. You may leave them empty to get a list of all the items, or
you may enter value in any of them, in which case the list of results will be filtered by them.

Once you hit the “search” button, the results will be listed. You can click any of them to go to the Edition
page, from where you will be able to edit the content for that item.

The bottom-most controls in the page allows you to navigate through the result pages (if there is more than
1) and even export the list to several file formats, including PDF and Excel spreadsheets:

C2g00
27 recordz found, =howing from 1 until 20. [First'Previous] 1, 2 [ Next! Lazsti]
Export: CSV | Excel| XML | POF

5.1.1.2 Edit

The Edit operation for a command routine is only accessible from the list page. To access the Edition
page of an item perform a Search Operation and click the desired item from the results list of the search.
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A formulary will be presented to you. Note the mandatory fields are marked with an asterisk’*’, you
cannot empty those fields.

»File | »Search | » SNMP Tool | » Configuration Management  » Administrator | » Inventory | » Help

(Command routine information:
» Nlame:

Edit Command Routine

» lame * [CREATE VoICE D0 _0 | »Description

» Routine *

|Command Routine for Do Section 0 (EMA Ericsson Create Voice)

;") SAUCCOMMAND

Fiekds marked with * are mandatory

Once you have edited the formulary, click “actions -> Save” to persist the changes. If everything
goes OK, you will be carried back to the List page of command routines.

If you want to cancel the edition, click “actions -> cancel. You will be carried back to the List page
of command routines without any change on the previous command routine.

»File | »Search | » SNMP Tool | » Configuration Management | » Administrator | » Inventory | » Help

(7]
ommand routine information:

» llame:
» De:

» Actions
» Save
» Cancel

» Name * |cREATE_vOICE_DO_0

| » pescription
»Routine *

[Command Routine for Do Section 0 (EMA Ericsson Create Voice) ]

#set (SAUCCOMMAND =

ICATIONKEY:AD, 1:ADKEY,1:A38,2;") SAUCCOMMAND

Fiekds marked with * are mandatory
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5.1.2 Template Operations

In this section are described the operation available for the templates.

5.1.2.1 Search/List

To access the Search (List) page, go to “Administrator -> ECP -> Activation Commands
Template -> Template -> List”

The search page will be displayed, empty for now. At the top-most part you will find the fields you can
use to filter your search:

» File ' » Search ' » SNMP Tool  » Configuration Management = » Administrator | » Inventory ' » Help

Search T

»Name »Manufacturer »Element Type »08S Version

. 7 v ! |
I —
Note that it is not mandatory to fill any of them. You may leave them empty to get a list of all the items, or
you may enter value in any of them, in which case the list of results will be filtered by them.

Once you hit the “search” button, the results will be listed. You can click any of them to go to the
Preview page, from where you can view a full preview of the template with all of its sections and
command routines.

The bottom-most controls in the page allows you to navigate through the result pages (if there is more than
1) and even export the list to several file formats, including PDF and Excel spreadsheets:

C2600
27 records found, =howing from 1 until 20. [First'Previous] 1, 2 [ Next! Lazsti]
Export: CSV | Excel| XML | POF

5.1.2.2 Create

To access the Creation page, go to “Administrator -> ECP -> Activation Commands
Template -> Template -> New”

The creation page will be displayed, empty for now.
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»File | » Search | » SNMP Tool | » Configuration Management | » Administrator | » Inventory | » Help wa -
Create new template:

» Actions

» Hame 3 | 9] » tement yper 9] » 05 Version o)

» Description [ | » common config v| »Undolast section [
ﬁW +] » Edit area

DO:

UNDO:

» Preview

Creation page is divided in two main parts. At the top of the form, user can fill the common fields of the

template: Name, Manufacturer, Element Type, OS Version, Description, Common Config and Undo last
Section.

» Name * » Manufacturer* [ + | » Element Type* + | »0S Version* v/

» Description » Common Config ( v | »Undolastsection [~ |

The second part of the web is a dynamically representation of the template structure.

Left side represents the tree, with all the sections that are part of the template. Right side has a top part in
which the command routines for the current selected section, can be edited. And bottom part is a dynamic

preview of the template. This preview will be updated automatically when user change any element of the
template.

New sections can be added clicking on the button on right side of the tree representation of the template.

» File | » Search  » SNMP Tool | » Configuration Management | » Administrator | » Inventory | » Help
Create new template:

» Actions

» Name * | | » Manufacturer v| »Element Type* v|»o0s

» Description | o 9] > indotast section | [

|

» Edit area

. » Selecta type:| Config v
& \i
AcCSECTION |

COMMIT ’—
¢
hic: ROLLBACK J

» Preview

There are two different types of sections:

Non common sections: By default, those are 3 fixed sections: CONFIG, COMMIT and ROLLBACK.

Those sections can’t be ordered and have a predefined order, specified on its data table of the data base
of HPSA. User only can add one equal common non section in the same template.
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Non common sections only display one command routine area.

2gatares
e ComT—|

COMMIT:

» Preview

» Editarea

ROLLBACK:

» Preview

> Section

[FEerrorT )

Common sections: user can add as many common sections as he want. Each common section added will

have a new sequence number to identify it. This kind of sections can be ordered clicking on the arrows on
right side of each section.

Common sections displays do and undo command routine areas.

» Edit area

|

DO:

FSecton? W E|

UNDO:

» Preview

MPLATE : Do]

5.1.2.3 Import

To access the Search (List) page, go to “Administrator -> ECP -> Activation Commands
Template -> Template -> Import”
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» SNMP Tool | » H
» Users »
» Roles »
i, Teams »
» Applications »
» Inventory views »
» Filters »
» Stored seachos . —
» Audited actions » » Preview
» Report Module I
»ECP » | ECP console »
» Sosad » |» Pool »
151> Snmp Administration » |» Subpool » [F522,1") scomnp
» Template »
» Common Configuration »
» Performance
DN, $MSTSDN: The » Activation Commands Templates | » Command Routine _» |SCOMMaND
» Instances » Template » | » New
P Dynemicconfigueations  » [T |»lmpor
» List

The import page will be displayed, empty for now.

h  » SNMP Tool nfiguration Management  » Administrator  » Iny

Import Template:

» Import Template

You can select the template for importing and create the template on it.

After selecting the file, click “actions -> Import”.

» File ' » Search  » SNMP Tool | » Configuration Management  » Administrator | » Inventory  » Help

Import Template:

» Actions
» Import

» Import Template
» Templats file:* C:\Documents and Seti

When you selected a template the system allows review the template. In this page user can change the
template parameters: Name, Description, Export date, Manufacturer, Element Type and OS Version.
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» Name *: ‘CONF\GURE_CALLFORWARD\NG

» Description: [configure callforwarding template form Ema Ericsson

In this formulary the mandatory fields are marked with an asterisk’*’, you cannot empty those fields.
When you try import a template three cases can happen:

1) When some parameter mandatory is empty the application throws error indicating the missing
parameter.

Invalid data

The following fields are invalid: Manufacturer , Element Type

Accept

2) Try import a template with same name, vendor, OS version and element type than other template
that exists in the application.

The system alerts about this problem. Throws the following message:

Import Template

There is a template already defined in the system
with this name for the specified vendor, element
type and version. If you want to overwrite the
existing template click Accept, otherwise click
Cancel and change some of the values.

|

Accept

3) The import is successful. The application shows Preview of template.

5.1.2.4 Edit

The Edit operation for an item is only accessible from the Preview page of each item. To access the
Preview page of an item perform a Search Operation and click the desired item from the results list of the
search.
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The preview page will be displayed, with the structure of the template.

» File | » Search | » SNMP Tool | » Configuration Management | » Administrator | » Inventory | » Help (O] ]
‘emplate information:
o ATE_voIC

» Actions

» Preview

~

Once you are in the Preview page of the desired item, click “Actions -> Edit":

A formulary will be presented this is the same used for creation, so the behavior is the same. Please refer
to the create template section of this manual o Know more about it.

»File | » Search | » SNMP Tool  » Configuration Management | » Administrator | » Inventory | » Help
[Template information:
» liame.
» 0 Version
» llame * CREATE_VOICE »Manufscturer® | Ericsson v| »ElementType:  |EMA4 v »0s Version* |sunoss v
» Description create voice template for Ema Ericsson| » Common Config | EMACommonConfig | »Undotast section |1
Wﬂ » Edit area
[FSection 0 MM E| 4seT ($AUCCOMMAND = "CREATE:AUCSUB:IMSI, $IMSI:KI, &
-
UNDO: \
» Preview

5.1.2.5 Export

The Export operation for an item is only accessible from the Preview page of each item. To access the
Preview page of an item perform a Search Operation and click the desired item from the results list of the
search.

The preview page will be displayed, with the structure of the template.
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»File | »Search | » SNMP Tool | » Configuration Management | » Administrator | » Inventory | » Help (O] ]
[Template information:

g

e

» Commen Config
} e

< ord

» 05 Version

» Actions

» Preview

Once you are in the Preview page of the desired item, click “Actions -> Export”:

» File  » Search  » MP Tool guration Management  » Administrator  »

Template information:
" Niame: RESUME_VOICE
» Deseription: resume voioa template for Ema Ericsson

» Comman Config: EMACemmenCentiy
» Manufacturer Ericsson

» Element Type: Emad

» 05 Version sun0s5

» Edit » Preview
» Export

» Delete
» Save

» Cancel

This utility lets will open or save the file in him own file system.
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» SNMP Tool  » Configuration Management | » Administrator | » Inves

» Name: RESUME_VOICE

» Preview

Descarga de archivs

Desea abiir o guardar este archivo?

Nambre: RESUME_VOICE_20120913_D85449.xml
Tipo: Documento L, 1,12 KB
De: localhost

e

() Aunaue los archivos procedenies de Intemet pueden ser diles.
g) algunos archives pusden legar a dafar o equipo. Si no confia en
el arigen, no cbra i quarde este archivo, ;Cual s o riesan?

5.1.2.6 Delete

The Delete operation for an item is only accessible from the Preview page of each template. To access the
Preview page of an item perform a Search Operation and click the desired item from the results list of the
search.

Once you are in the Preview page of the desired item, click “Actions -> Delete”.
P E—————— T

Template information:

» Edit » Preview
» Delete

» Cancel

This will delete the selected Template, as well as all its relationships with Sections and Command
Routines. A confirmation dialog will be displayed.
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5.2 Querying Command Templates from Workflows

QueryCommandTemplate is the node is responsible for consulting the command template from the
commands cache. The class name for this node is

com.hp.ov.activator.mwfm.component.tmpc. QueryCommandTemplate and it recognizes the following
configuration parameters:

Parameter Reuwed Description Default

module The name of the module invoked None

result_status Yes The name of the case-packet None
variable in which the status will be
stored

name Yes The name of the service for which None
are querying the template

manufacturer Yes The name of the manufacturer of None

the target in which the service is
going to be activated
element_type_group Yes The name of the manufacturer of None
the networkelement in which the
service is going to be activated
os_version_group Yes The name of the osversiongroup of | None
the networkelement in which the
service is going to be the name of
the case-packet variable in which
the template will be stored. The
template contains all the commands
for the service activation
Template Yes The name of the case-packet None
variable in which the template will
be stored. The template contains all
the commands for the service
activation

common_config Yes The name of the case-packet None
variable in which the common
config name will be stored
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6 Web Service Connectivity

The WSC (Web Service Connectivity) feature of MSA allows generating service descriptors from a given
WSDL file to invoke web service operations from within workflows. In order to get this feature to work the
WSC module must be defined in the mwfm.xml file as explained in the Installation and Administration

Guide.

6.1 Customizing Service Descriptors

Service descriptors define how the WSC module makes requests to a given web service endpoint using
the stub generated for it.

When generating a service for a given WSDL file, a descriptor is automatically generated along with the
corresponding service stub (Java client code required to perform requests to the service). These descriptors
contain information about the supported operations, their corresponding overloads (if any) and
input/output/fault parameters based on the Java methods in the framework-generated stub and their
arguments.

Automatically generated descriptors can then be modified in order to add aliases for parameters or
operations to ease workflow development. In order to edit the service descriptor corresponding to a given
service, select Actions 2 Service 2 Edit Descriptor from the service information view in the WSC
application of the Solution Container (refer to the installation and administration reference for more
information on this) and you will be presented with a screen like the following:

» File | » Search  » SNMP Tool | » Configuration Management | » Administrator | » Inventory | » Help

Service Information::

» Id: 5
w Name: ota W5 technology: AXIS
u Description: OTA #» Endpoint class name: com.gemalto.apiscap. wsdl.ge...
w Wendor: Gemalto #» Service locator class name: com.gemalto.apiscap. wsdl.gc...
# Element type group: Eemalto w Get service method: getGCOTA
» 05 wersion group: Gemalto » State: ACTIVE
» Actions
. .
@ ota _ Service
- i getSuscriber
-~ & deleteApplet Senice ota
-~ @ checkTransaction o -
. . esCcriptian
- & isOTAConnectionOk P i
- & getApplets 4
- & newMSISDN
-~ & isSASConnectionOk
H [ -~ 1 . a [

From here you can customize the service descriptor. The tree view in the left represents the descriptor
structure. In order to customize a descriptor element, just select it from the tree and its details will appear
in the right pane.

The topmost element denoted by the @ icon represents the service itself, and only the description (for
documentation purposes) can be modified.

Under it are the service methods, represented by the i icon. Methods correspond to web service
operations and have the following editable fields:

e Alias: an alternative name for the method that can be used in workflows to refer to it when using
the WSCRequestNode.
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e Description: for documentation purposes.

Apart from this, methods may have input/output and fault parameters as seen in the example below:

The € INPUT group contains inpuiﬁlorometers. They may be optionally grouped into request

configurations, represented by the L= | icon, if the method is overloaded (i.e. there are several operations
with the same name in the original WSDL).

The B OUTPUT group contains output parameters.

The "&' FAULT group contains an alternate collection of output parameters in the case the invocation
results in a fault response.

i @ota Only parameters and request configurations are selectable, the group items
{:‘% gi“;ﬁ?ber are there for tree structure purposes.
@%"T“El msi) More detailed explanations of the different elements follow:
4 [g]bylcCID
4 [7]1CCID (iceid) Request configurations represent the different variants of a given
@S%SSI:SSDDNN (msisdn) method. Each of them has a different set of input parameters. From the
4 B OUTPUT corresponding detail form the name of the request configuration may be
"'S:a%'lfl_(icc_id} customized so it can be used from workflows instead of the default
NE MS|S([IRSEI},HsiSdn} methodname#N. Non-overloaded methods have only one request
4. [[] PROFILE (profile) configuration and thus it is not displayed in the tree, with its input
" I,‘_';IES[TATUS (status) parameters shown just under the INPUT group.
i [7] fault_code (faultCode)

Input parameters may be represented by the |:|,|:I or E icons
depending if they represent basic, bean or array member types respectively. Upon selecting those the
following fields will be displayed:

e Path: the parameter path. More information on paths below. The path is displayed for
informative purposes and it cannot be modified.

e Class: the Java class name corresponding to the parameter, displayed for informative purposes
only if it is defined in the descriptor.

e Alias: the parameter alias. An input parameter can be referenced by its alias instead of the
complete path. Aliases must be unique inside a given request configuration. When a parameter is
aliased, the alias will be displayed in the tree in place of the parameter path, which will be
displayed between parentheses aside it.

o Default Value: default value for the parameter if it is not specified when making the request.

o Description: for documentation purposes.

e Mandatory: if checked, the parameter must be specified when making a request. Mandatory
parameters are displayed in bold in the tree.

o Encrypted: if checked, the value assigned to this parameter at request time will be assumed to
be encrypted, and thus it will be decrypted before sending it to the target equipment.

Note: for array member parameters only the path, class and description fields will be displayed as they
cannot be aliased.

Output/fault parameters may be represented by the D,':I or B icons depending if they
represent basic, bean or array member types respectively. Upon selecting those the following fields will
be displayed:
e Path: the parameter path. More information on paths below. The path is displayed for
informative purposes and it cannot be modified.
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e Alias: the parameter alias. An output/fault parameter can be referenced by its alias instead of
the complete path. Aliases must be unique inside a given OUTPUT/FAULT group. Only aliased
parameters will be included in the output parameter map when using output_attr_map in
WSCRequestNode. When a parameter is aliased, the alias will be displayed in the tree in place
of the parameter path, which will be displayed between parentheses aside it.

e Description: for documentation purposes.

Note: for array member parameters only the path and description fields will be displayed as they cannot
be aliased.

Once you are done customizing the descriptor you can save it by selecting Actions = Descriptor 2 Save.
To discard all changes made to the descriptor, select Actions = Descriptor 2 Cancel.

6.2 Paths

Paths used to reference attributes are based on the following syntax:

| path_element1.path_element2...path_elementN

Where the sequence of the path elements represents a full path inside the web service request or
response/fault body to locate the attribute. Each element in the path must correspond to the name of a
property of the previous object, while array indexes are expressed in the form object#index. So, the
following path

| foo.bar.baz#2.qux

would translate to

| foo.getBar().getBaz()[2].getQux()

in Java code.

6.3 Making Web Service Requests from Workflows

In order to make requests to web services from workflows through the WSC module, a new node by the
name WSCRequestNode is included. The class name for this node is
com.hp.ov.activator.mwfm.component.wsc. WSCRequestNode and it recognizes the following
configuration parameters:

Parameter ‘ Required Description ‘ Default

equipment_target Yes The name of a named endpoint or | None
the actual endpoint URL

module Yes The name of the WSCModule to be | None
used for making the request

service_name Yes The name of the service to be None
invoked

method_name Yes The name of the method to be None
invoked (web service method name
or alias)

request_configuration No The name of the request default
configuration to use.

exec_time No The name of variable where the None
execution time is stored.
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request_trace No The name of variable where the None
trace of the request is stored.
response_trace No The name of variable where the None
trace of the response is stored.
throw_excep No Used to throw exceptions or use true
RET_VALUE and RET_TEXT to return
information about the errors without
launching exception.
input_attr_map No A map containing input attributes None
values. The map keys are
interpreted as attribute alias or
paths referencing request elements
(input attributes) that must be
assigned the corresponding values.
output_attr_map No A map specifying where output None
attributes values should be stored.
The map keys are interpreted as
attribute alias or paths referencing
response elements (output attributes)
and the corresponding values are
the names of the variables where
the attribute value must be stored.
input_attr_nameO No An attribute alias or path None
input_attr_name1 referencing a request sub-element
(input parameter).
input_attr_nameN
input_attr_value0O No Value to be assigned to the None
input_attr_valuel corresponding request attributes. It
may be a variable or a constant.
input_attr_valueN
output_attr_nameO No An attribute alias or path None
output_attr_namel... referencing a response sub-element
output_attr_nameN (output parameter).
output_attr_value0O No The name of the case-packet None
output_attr_valuel... variable where the content of the
output_attr_valueN corresponding output attribute
should be stored.

For more information on how input/output parameter paths work, please refer to the previous section.

In case a specific attribute name is defined in both the input/output_attribute_map and directly specified
as an input/output_attribute_attr_name/value pair, the value specified for the pair takes precedence.

Note that in order to make requests using a certain WSC service it has to be properly generated and in
the ACTIVE state. Both services and named endpoints are loaded along with the HPSA configuration, so
after making any changes to them the HPSA configuration must be reloaded in order for them to take
effect.

What follows is an example of a WSC invocation from one of the workflows shipped with the MSA
solution:

<Process-Node>
<Name>Call WS</Name>
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<Action>
<Class-Name>com.hp.ov.activator.mwfm.component.wsc. WSCRequestNode</Class-Name>
<Param name="exec_time" value="constant:invocation_time"/>
<Param name="input_attr_map" value="S_INPUT"/>
<Param name="method_name" value="constant:deleteUser"/>
<Param name="module" value="wsc_module_name"/>
<Param name="request_trace" value="COMMAND_SENT"/>
<Param name="response_trace" value="NE_OUTPUT"/>
<Param name="service_name" value="constant:voicemail"/>
<Param name="target_target" value="beanEndpoint.Targettarget" />
<Param name="throw_excep" value="false"/>
<Param name="input_attr_name0" value="operID"/>
<Param name="input_attr_value0" value="Targetuser"/>
<Param name="output_attr_name0" value="response"/>
<Param name="output_attr_value0" value="error_code"/>
<Param name="input_attr_name1" value="operPwd"/>
<Param name="input_attr_value1" value="Targetpassword"/>

</Action>

<Next-Node>Switch</Next-Node>

</Process-Node>

Here we are passing the S_INPUT parameter map exactly as provided by SOSA as the input parameter
map; this along with descriptor customization can make workflow development much easier and
manageable.
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7 Report Module

The report module allows for defining arbitrary reports on database information, being able to specify
filter conditions and how the query results are presented.

The report are defined in an xml file, where basically are defined the queries used for each report, the
format of this xml file are described in the section 7.2 of this document.

7.1.1 Accessing the Report Module Web Ul

Report Module (RM) is a web application part of the Solution Container (SC). To access RM open the SC
in a supported web browser and go to “Administrator -> Report Module” as shown below:

Solution Container - HP |

» File | » Search  » SNMP Tool | » Configuration Management [ERSSIGINEEIE » Inventory H
» Users » |
» Roles » |:
» Teams W
» Applications L
» Inventory views » |:
» Filters W
A < corches M
» Audited actions W
» Report Module
» ECP »
» Sosal »
» Snmp Administration W

7.1.2  Available Operations

There is only one possible operation to execute through this module: Search operation. RM will execute
the query selected by the user with the input and output parameters the user has previously set.

» File | » Search

» SNMP Tool | » Configuration Management | » Administrator | » Inventory | » Help
» From (date) » Select output farmat
| & [Table |

» Select Query |
Proccess Time Workflow Ni » » To (date)

Pocteis T
[Proccess Time Workflow Name l:l = DL

Seach by MSISDN
Search Vendor
Executions group by WF Name

Once you hit the “Search” button, the results will be listed, it will forward to the resulting data page with
the format specified by the user.

» File  » Search » SNMP Tool  » Configuation Management  » Administrator | » Inventory | » Help
» From (date) » Select output format
» Select Quary [gr10720m | &= |Tabls V‘
Proceess Time Workdlow Nan ™|, 1o (date)
= MR
TOTAL_EXECUTIONS WORKFLOW_NAME AVG_PROCESS_TIME AVG_NE_ACTIVATION_TIME ERROR
38 MOBILE_HLR_DELETE 147.17 5144 28
18 MOBILE_HLR_SET 5913 2
4 T .3; a5
: ::2 4 ;33

518 MOBILE_HLR_GREATE
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The input form is automatically generated based on the configuration file.

7.2 Report Module configuration

This module reads an xml file with all required information about the queries definition.

This file is called “ReportModuleQueryDefinition.xm|” and it's on the next path:
$JBOSS_HOME/standalone/deployments/hpsa.ear/ep.war/WEB-INF/classes/reportmodule.

Note that this file is deployed in the WEB-INF server directory, so it is needed to restart the server in order
to see any change that it is committed in this configuration file.

7.2.1 Query Section

The ReportModuleQueryDefinition file can have as many query sections as it is needed. Those sections
represent each possible operation that could be executed in the Report Module Ul.

Code example:

<query>
<name>Proccess Time Workflow Name</name>
<description>Proccess Time Workflow Nam</description>
<order>20</order>
<maxlengthresult>200</maxlengthresult>
<sql><![CDATA[
select sum(total) as Total_Executions, WORKFLOW_NAME_DO as Workflow_Name,sum(AVG_PROC_TIME) as
AVG_Process_Time,
sum(AVG_NE_ACT) as AVG_NE_Activation_Time,sum(error) as Error
from
(SELECT COUNT(*) TOTAL,
WORKFLOW_NAME_DO,
ROUND(AVG(PROCESSING_TIME),2) AVG_PROC_TIME,
ROUND(AVG(NE_ACT TOTAL TIME),2) AVG_NE_ACT,
0 AS ERROR
FROM HISTORY_HBM_SA
WHERE ( (START_TIME BETWEEN TO_DATE ('$From$', 'DD-MM-YY HH24:MI:SS')
AND TO_DATE ('$To$', 'DD-MM-YY HH24:MI:SS")))
GROUP BY WORKFLOW_NAME_DO
UNION ALL
SELECT O TOTAL,
WORKFLOW_NAME DO,
0 AVG_PROC_TIME,
0 AVG_NE_ACT,
COUNT(*) AS ERROR
FROM HISTORY_HBM_SA
WHERE ( (START_TIME BETWEEN TO_DATE ('$From$', 'DD-MM-YY HH24:MI:SS")
AND TO_DATE ('$To$', 'DD-MM-YY HH24:MI:SS")))
AND (sosa_code <> 0)
GROUP BY WORKFLOW_NAME_DO )
group by workflow_name_do
1></sql>
<input>
<parameter>
<name>From</name>
<type>date</type>
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<description>From Date</description>
</parameter>
<parameter>

<name>To</name>

<type>date</type>

<description>To Date</description>
</parameter>

</input>
<redirections>
<redirect>
<jsp>table.jsp</jsp>
<type>Table</type>
</redirect>
</redirections>
</query>

7.2.1.1 Name Section

Name section is the identifier of the query block. This name appear in Ul on select field to allow the user
to select the desired query to execute

| <name>Proccess Time Workflow Name</name>

Solution Container - HP i
» From (date) ) » Select output format
» Select Query ' & Table B
:g::gf;pﬁt b » To (date) -
E’ro;cess Time Workflow | i

\Executions group by WF]

7.2.1.2 Description Section

Description section is a long description of the query. No more utility.

| <description>Proccess Time Workflow Nam</description>

7.2.1.3 Order Section

Order section allows the user to specify the order that queries will have on select field in the application.

| <order>20</order>

7.2.1.4 Max Length Result section

User can define the max number of results will be shown as a result of a query.

| <maxlengthresult>200</maxlengthresult>

7.2.1.5 SQIL Section

This section contains the SQL query that can be defined to recover the information desired.

I//

Note that it is very important to use the CDATA tag if you want to use any “special” character like <, >
or similar in the query, because the configuration file it's an xml file and user needs to escape this kind of
“special” characters.
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<sql><![CDATA[

11></sql>

7.2.1.6 Input Section

This section contains as many input parameters as needed as criteria in the query. Ul draw an input field
for each parameter is defined. If field is a date field, a calendar component will be rendered next fo it.
Boolean parameter will be rendered as a radio decision input.

<parameter>

<name>From</name>

<type>date</type>

<description>From Date</description>
</parameter>
<parameter>

<name>To</name>

<type>date</type>

<description>To Date</description>
</parameter>

» From (date) »USeVIAgc»tdoutpq‘tﬂfo‘r»mgt7
» Select Query 7 = Table >
SOSA Report v

|SOSA Report
|Proccess Time Workflow
\Executions group by WF

» To (date

On query sections, parameters must be used as it's shown below, between $ symbol:

| WHERE ( (START_TIME BETWEEN TO_DATE ('$From$', 'DD-MM-YY HH24:MI:SS'ription>From Date</description>

7.2.1.7 Redirections Section

This section allows defining different types of data result representation.

<redirections>
<redirect>
<jsp>table.jsp</jsp>
<type>Table</type>
</redirect>
</redirections>

In this section it is defined the JSP previously implemented to be displayed with the result, and the type of
representation required.

It is possible to define as many different redirections as needed. For each redirection defined, one option
will be filled on the select output format of the Ul.

<redirections>
<redirect>
<jsp>table.jsp</jsp>
<type>Table</type>
</redirect>
<redirect>
<jsp>/sp/reportmodule/customjsp/mobileSosaHistoryAxisGraph.jsp</jsp>
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<type>PlotXY</type>
</redirect>
<redirect>
<jsp>/jsp/reportmodule/customjsp/mobileSosaHistoryPieGraph.ijsp</jsp>
<type>PieGraph</type>
</redirect>
</redirections>

» Select output format
Table ¥

Table
PlotXY

7.3 Redirections (Types of Representations)
In previous section it was defined that this application allows define different types of data result
representation.

By default, users always have table representation. But users can implement new different output format
representations.

Any new representation must be implemented in a new JSP file. This new JSP file must be located in the
path: $JBOSS_HOME/server/diagnostic/deploy/hpovact.sar/activator.war/jsp/reportmodule/customisp
This directory contains all customized implemented files.

An example of a pie chart will be:

<%@page import="java.math.BigDecimal" %>

<%@page import="java.text.SimpleDateFormat" %>

<%@ page import="com.hp.reportmodule.utils. CustomRowSetDynaClass" %>

<%@ page import="java.util.List"%>

<%@ page import="java.util.lterator" %>

<%@ page import="org.apache.commons.beanutils.DynaBean" %>

<%@ page import="com.hp.reportmodule.reportmodulequerydefinition.Parameter;" %>

<html>

<script src="/activator/javascript/hputils/datetimepicker.js"></script>

<script language="javascript" type="text/javascript" src="/activator/javascript/reportmodule/jquery.is"></script>
<script language="javascript" type="text/javascript" src="/activator/javascript/reportmodule/jquery.jgplot.js"></script>
<script language="javascript" type="text/javascript" src="/activator/javascript/reportmodule/excanvas.s"></script>
<script language="javascript" type="text/javascript" src="/activator/javascript/reportmodule/plugins/jquery.jgplot.js"></script>
<script language="javascript" type="text/javascript"
src="/activator/javascript/reportmodule/plugins/jgplot.pieRenderer.js"></script>

<%
String useRandomColor = (String) request.getSession().getAttribute(
com.hp.ov.activator.mwfm.futuregui.servlet. Constants. USE_RANDOM_COLOR);
String mainColor = (String) request.getSession().getAttribute(
com.hp.ov.activator.mwfm.futuregui.servlet. Constants. APP_MAIN_COLOR);

CustomRowSetDynaClass rsdc = (CustomRowSetDynaClass) request.getSession().getAttribute("rsdc");
SimpleDateFormat sdf = new SimpleDateFormat();
SimpleDateFormat sdf2 = new SimpleDateFormat();
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Object[] values = rsdc.getColumn("OK").getColumnValues().toArray();

Obiject[] values2 = rsdc.getColumn("KO").getColumnValues().toArray();
%>
<head>
<meta http-equiv="Content-Type" content="text/html; charset=ISO-8859-1">
<link rel="stylesheet" type="text/css" href="/activator/javascript/reportmodule/jquery.jgplot.css" />
<link rel="stylesheet" href="/activator/css/future-gui/estilos<%=(useRandomColor.equals(com.hp.spain.futuregui. Constants. TRUE)) ?
mainColor: ""%>.css">
<link rel="stylesheet" href="/activator/css/future-
gui/subestilos<%=(useRandomColor.equals(com.hp.spain.futuregui.Constants. TRUE)) ? mainColor: ""%>.css">
<style type="text/css">

body {

overflow: scroll;
}
</style>
<style type="text/css" media="screen">
.jgplot-axis { fontsize: Tem;}
.igplot-axis { fontsize: Tem;}
.jgplotlegend {  fontsize: 2em; }
</style>
<title>Plot</title>
</head>
<body>

<script type="text/javascript" language="javascript">
$(document).ready(
function(){
$.jgplot.config.enablePlugins = true;
var totalOK=0;
var totalError=0;
<%
for (int i=0; i<rsdc.getRows().size(); i++){
%>
total OK=totalOK+<%=values[i]%>;
totalError=totalError+<%=values2[i]%>;

<%
}
%>
var data=[['OK',totalOK],['ERROR', totalError]];
var plot = [Query.jgplot (‘chart1’, [data],
gridPadding: {top:0, bottom:38, left:0, right:0},
seriesDefaulis:{renderer:$.jgplot.PieRenderer, trendline:{show:false},
rendererOptions: { padding: 8, showDatalabels: true}
L
legend:{show:true, placement: 'insideGrid', rendererOptions: {numberRows: 1},
location:'ne’,
marginTop: '15px'
}
}
)i
b
</script>
<?php include "nav.inc"; ?>
<div id="chart1"style="margin-top: 20px; margin-left: 20px; width: 1000px; height: 400px;"></div>
<div style="padding-top: 20px"> </div>
</body>
</html>
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Note that for this application it has been used a graphic library called jgplot.

User must implement its own JSP files with this library. You can found more information about jgplot in the
next URL:

http://www.jgplot.com/

igplot usage example: http://www.igplot.com/docs/files/usage-xt.html
igplot examples: http://www.jgplot.com/fests/
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8 SmartBean Search Module

This is an HPSA module intended to cache some information in the memory to avoid access to the
database. This functionality is used to improve the performance in the workflow.

The information that will be cache in memory need to be defined into the configuration table, this
configuration table is stored in the database.

Additionally this

8.1 Indexed Bean Configuration

SBS Module provisions SBSM_CONF table with the configuration of the beans that must be cached in
memory by the module.

SBSM_CONF is defined in the configuration inventory file and it will be provisioned with the following
mandatory fields:

Classname: is a String that contains the class name of the bean which has to be cached.

Indexes: is a String that contains the Indexes used for caching the bean data.
It Indexes field has different values, they will be separated by “:”, and the different indexes for a bean

u,n

will be separated by “;” as it is showed in the following example.

INSERT INTO SBSM_CONF (CLASSNAME, INDEXES, ISPARENT__) VALUES ('com.hp.ov.activator.cr.inventory.NetworkElement',
'Name:Cluster;NetworkElementld', 0);

8.2 Workflow Nodes

There are three nodes from which workflow invocations could be fulfilled:
» SBSGetBeanNode.
»  SBSGetBeanWithPatternNode.
» SBSGetBeansNode.

In this section it will be described what the SBSM nodes do as well as its configuration reference.

8.2.1 SBSGetBeanNode

SBSGetBeanNode enables workflows to recover a bean instance using the values of fields indexed in the
cache as key, so the key provided has to be the same as the key of the object returned.

Parameter Required Description Default Type

module Yes The name of the module to be | None String
used.

bean Yes QName of bean class. None String

index_fieldO, Yes (at least The name of the fields used to | None String

index_field1, index_field0) index the beans (in the same

order they have been

index_fieldN provisioned in database).

index_valueO, Yes (at least The value for each field used | None String
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index_valuel,

index_valueN

index_value0)

as criteria.

wildcard_fieldO,
wildcard_field1,

wildcard_fieldN

The name of the fields used
as wildcard variants if a result
has not been found with the
index_field and index_value
criteria. Note that this
wildcard_fields can only be a
subset of index_fields
provided.

None

String

wildcard_valueO

14

wildcard_valuel

' 4

wildcard_value
N

The value for each field when
the wildcard is used.

None

String

wildcard_mode

Mode used to generate
different criteria combinations
attending to wildcards
modifiers provided. The value
only can be ALL_IN_ONE
(only one variant is generated
replacing all the values of the
wildcards at the same time) or
SEQUENTIAL (the number of
variant is related to the
number of wildcard_fields
provided). See example
bellow in order to understand
the variants generation
mechanism.

None

String

result

Yes

Name of variable where
bean instance will be stored.

None

Object

config

Map with dynamic
configuration of node. All
key-value pairs can overwrite
the values provided statically
in the workflow.

None

Object

throw_excep

Is used to throw exception or
use RET_VALUE and RET_TEXT
to return information about
the errors without launching
exceptions.

true

Boolean

The following example shows how to invoke SBS Get Bean Node:

<Process-Node>

<Name>Query platform to activate</Name>

<Action>

<Class-Name> com.hp.ov.activator.mwfm.component.sbsm.SBSGetBeanNode</Class-Name>
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<Param name="bean" value="constant:com.hp.activation.mobile.inventory. VOICEMAIL_ZTE_MAP"/>
<Param name="module" value="constant:SmartBeanSearch"/>
<Param name="result" value="constant:beanVoiceMail"/>
<Param name="throw_excep" value="false"/>
<Param name="index_field0" value="constant:Mdn"/>
<Param name="index_value0" valve="plataform_name"/>
<Param name="index_field 1" valve="Targetrole"/>
<Param name="index_value1" value="system"/>
</Action>
</Process-Node>

8.2.1.1 Wildcard Feature

When the search for a certain cached bean has been performed with the index_field and index_value
criteria and no results have been found, SBSGetBeanNode gives the opportunity to use wildcards fields
as search criteria.

There are different strategies in order to generate alternative variants of search criteria, depending on the
value wildcard_mode parameter takes:

ALL_IN_ONE: if only one variant is generated replacing all the values of the wildcards at the
same fime.

SEQUENTIAL: if the number of variant is related to the number of wildcard_fields provided.

Let's take the following values and wildcards as an example:

index_field0 fieldA index_value0 valueA
index_field1 fieldB index_value1 valueB
index_field2 fieldC index_value2 valueC
wildcard_field0 fieldA wildcard_valueO DEFAULT
wildcard_field1 fieldC wildcard_valuel default

It wildcard_mode has ALL_IN_ONE value, the variant generated would be only:

| DEFAULT:valueB:default

Otherwise, if wildcard_mode gets SEQUENTIAL value, the variants generated would be:

DEFAULT:valueB:valueC
DEFAULT:valueB:default

In this case, the order of wildcard_fields is used as sequence in the replacement of original values.

This feature can also be used by the following node (SBSGetBeanWithPatternNode).

8.2.2 SBSGetBeanWithPatternNode

SBSGetBeanWithPatternNode enables workflows to recover a bean instance using the pattern of fields
indexed in the cache as key. With this node, the field keys can be read during the caching process as a
regular expression and the values provided in the node will try to match one of the regular expressions
used as index. It can be useful to define a mapping.

Parameter Required Description Default Type

module Yes The name of the module to | None String
be used.

bean Yes QName of bean class. None String

index_fieldO, Yes (at least The name of fields used to None String
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index_field1,

index_fieldN

index_fieldO)

index the beans (in the
same order what they have
been provisioned in
database).

index_valueO,
index_valuel,

index_valueN

Yes (at least
index_value0)

The value for each field
used as criteria.

None

String

wildcard_fieldO,
wildcard_field1,

wildcard_fieldN

The name of fields used as
wildcard variants if a result
has not been found with the
index_field and index_value
criteria. Note that
wildcard_fields only can be
a subset of index_fields
provided.

None

String

wildcard_valueO

’

wildcard_value1

’

wildcard_value
N

No

The value for each field
when the wildcard is used.

None

String

wildcard_mode

Mode used to generate
different criteria
combinations attending to
wildcards moditiers
provided. The values only
can be ALL_IN_ONE (only
one variant is generated
replacing all the values by
the wildcards at the same
time) or SEQUENTIAL (the
number of variant is related
to the number of
wildcard_fields provided).
See example bellow in
order to understand the
variants generation
mechanism.

None

String

result

Yes

Name of variable where
bean instance will be
stored.

None

Object

config

Map with dynamic
configuration of node. All
key-value pairs can
overwrite the values
provided statically in the
workflow.

None

Object

throw_excep

Is used to throw exception

true

Boolean
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or use RET_VALUE and
RET_TEXT to return
information about the errors
without launching
exceptions.

The following example shows how to invoke SBS Get Bean with Pattern Node:

<Process-Node>
<Name>Query platform to activate</Name>
<Action>
<Class-Name>com.hp.ov.activator.mwfm.component.sbsm. SBSGetBeanWithPatternNode</Class-Name>
<Param name="bean" value="constant:com.hp.activation.mobile.inventory. VOICEMAIL_ZTE_MAP"/>
<Param name="module" value="constant:SmartBeanSearch"/>
<Param name="result" value="constant:beanVoiceMail"/>
<Param name="throw_excep" value="false"/>
<Param name="index_field0" value="constant:Mdn"/>
<Param name="index_value0" valve="plataform_name"/>
<Param name="index_field 1" valve="Targetrole"/>
<Param name="index_value 1" valve="system"/>
</Action>
</Process-Node>

8.2.3 SBSGetBeansNode

SBSGetBeansNode enables workflows to recover an array of bean instances using the values of fields
indexed in the cache as key.

Parameter Required Description Default Type

module Yes The name of the module to | None String
be used.

bean Yes QName of bean class. None String

index_fieldO, Yes (at least The name of fields used to | None String

index_field1, index_fieldO) index the beans. All the

index_field provided have

index_fieldN to be included

simultaneously at least in
one index registered for the

bean.
index_valueO, Yes (at least The value for each field None String
index_valuel, index_value0) used as criteria.
index_valueN
result Yes Name of variable where None Object
array of bean instances will
be stored.
config No Map with dynamic None Object

configuration of node. All
key-value pairs can
overwrite the values
provided statically in the
workflow.

throw_excep No Is used to throw exception true Boolean
or use RET_VALUE and
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RET_TEXT to return
information about the errors
without launching
exceptions.

The following example shows how to invoke SBS Get Beans Node:

<Process-Node>
<Name>Query platforms to activate</Name>
<Action>
<Class-Name> com.hp.ov.activator.mwfm.component.sbsm. SBSGetBeansNode</Class-Name>
<Param name="bean" value="constant:com.hp.activation.mobile.inventory. VOICEMAIL_ZTE_MAP"/>
<Param name="module" value="constant:SmartBeanSearch"/>
<Param name="result" value="constant:beanVoiceMailArray"/>
<Param name="throw_excep" value="false"/>
<Param name="index_field0" valve="constant:Mdn"/>
<Param name="index_value0" valve="plataform_name"/>
</Action>
</Process-Node>
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9 Bulk Activations

The bulk activations protocol adapter allows customers to load a request file composed by multiple
activation requests that will be loaded by SOSA. In order to do so, the operator must place a bulk
activation request file in the specified request directory, usually accessible through FTP, and SOSA will
then detect it and start the processing. Additionally, there is a complementary Solution Container
application for this feature allowing users to upload, schedule and cancel bulk activation requests through
the web interface. Once processing of the request file has been completed, a result file with the original
requests and their corresponding responses will be placed in the results directory as well as the original
request file will be archived. Optionally, a bulk activation report may be sent via e-mail to the specified
recipients including the results file as an attachment.

9.1 Protocol Adapter Configuration

In order to use the bulk activations feature, the bulk protocol adapter must be configured in SOSA:

<ProtocolAdapter className="com.hp.ov.activator.mobile.sosa.protocoladapters.bulk.BulkProtocolAdapter"
name="BULK_PA">

<Parameter name="db.pool.name" value="db_sosa_catalog"/>

<Parameter name="bulk.archive.directory" value="/path/to/bulk/archive"/>
<Parameter name="bulk.request.directory" value="/path/to/bulk/requests"/>
<Parameter name="bulk.result.directory" value="/path/to/bulk/results"/>

<Parameter name="bulk.default.username" value="ftpuser"/>

<Parameter name="bulk.mail.from" value="sosa@yourcompany.com"/>

<Parameter name="bulk.mail.server.authenticate" value="true"/>

<Parameter name="bulk.mail.server.hostname" value="mail.yourcompany.com"/>
<Parameter name="bulk.mail.server.password" value="secret"/>

<Parameter name="bulk.mail.server.port" value="25"/>

<Parameter name="bulk.mail.server.secure" value="false"/>

<Parameter name="bulk.mail.server.username" value="smtpuser"/>

<Parameter name="bulk.mail.subject" value="Bulk Activations Report"/>

<!-- Fine tuning

<Parameter name="bulk.disable.persistence.for.services" value="MCA,SDP,PTT"/>
<Parameter name="bulk.enable.persistence.for.services" value="MNP,HLR"/>
<Parameter name="bulk.max.attachment.size" value="20971520"/>
<Parameter name="bulk.monitor.interval" value="5000"/>
<Parameter name="bulk.override.persistence" value="false"/>
<Parameter name="bulk.so.timeout" value="60000"/>

-->

</ProtocolAdapter>

This protocol adapter supports the following configuration parameters:

‘Parameter ~ Mandator Default value ~ Description
y
db.pool.name Yes Database pool name
bulk.archive.directory Yes Filesystem path to the archive

directory where processed
activation requests will be stored in
the form ORIGINAL_FILENAME
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_YYYYMMDD-HHMMSS

bulk.request.directory

Yes

Filesystem path to the requests
directory where activation requests
must be placed for processing

bulk.result.directory

Yes

Filesystem path to the results
directory where activation reports
will be output in the form
ORIGINAL_FILENAME_result_YYYY
MMDD-HHMMSS

bulk.default.username

bulk

The default username that will be
assigned to request files not
originated from the Solution
Container application

bulk.mail.from

Yes

Sender e-mail address for
activation reports

bulk.mail.server.authenticat
e

No

False

Whether to use authentication for
connecting with the SMTP server

bulk.mail.server.hostname

SMTP server hostname

bulk.mail.server.password

SMTP server password

bulk.mail.server.port

25

SMTP server port

bulk.mail.server.secure

False

Whether to establish a secure
(SSL/TLS) connection to the SMTP
server

bulk.mail.server.username

SMTP server username

bulk.mail.subject

Bulk Activations Report

Message subject to be used in
mailed activation reports

bulk.disable.persistence.for
.services

Comma-separated list of service
names for which SOSA persistence
will be forcefully disabled when
processing requests, no matter
what is specified in the service
catalog

bulk.enable.persistence.for
.services

Comma-separated list of service
names for which SOSA persistence
will be forcefully enabled when
processing requests, no matter
what is specified in the service
catalog

bulk.max.aftachment.size

No

Maximum filesize (in bytes) for
attached result files in mailed
activation reports

bulk.monitor.interval

No

60000

Interval of time (in ms) between
checks for new activation requests

bulk.override.persistence

No

Can be “enable” or “disable”. If
specified, persistence will be
forcefully enabled or disabled no
matter what is specified in the
service catalog for orders
originated from the protocol
adapter
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9.2 Request File Format

Bulk activation request files are ASCII text files that must adhere to the following structure:

BEGIN

<request parameters>
COMMANDS

<activation requests>
END

9.2.1 Request Parameters

Request parameters allow configuring several aspects of the bulk activations request and may be
specified in the BEGIN section of the request file in the form

| PARAMETER_NAME : PARAMETER_VALUE;

The following request parameters are supported:

Parameter ' Default value
MAIL_ADDRESS

Description

Comma-separated list of e-mail addresses where
the activation report will be e-mailed on
completion. If unspecified, no e-mail will be sent

MAIL_TEXT Bulk activation job A custom text for the mailed activation report
finished successfully.
MAX_PARALLELISM 1 The maximum number of parallel threads used
to process requests of this file. If this number is
1 (default value), requests will be processed
sequentially, otherwise it is not guaranteed
RETRY An expression in the form C,N,/ allowing to

specify that in case a request in the file fails
with error code C, N retries should be
attempted with a delay of | seconds between
them. There may be as many RETRY parameter
declarations as necessary.

9.2.2 Activation Requests

Activation requests must be placed in the COMMANDS section of the request file and must conform to the

SCLP (SOSA Command-Line Protocol) specification:

| SERVICE_ACTION_NAME .SERVICE_NAME .OPERATION PARAMS PARAM1=VALUE1, PARAM2=VALUEZ2, .. PARAMn=VALUEn;

For example:

| MOBILE.VOICEMAIL.CREATE PARAMS MSISDN=180561234567, IMSI=310150123456789, LANGUAGE=2, PASSWORD=secret;

In case there are no input parameters the PARAMS part of the command must be omitted:

| SERVICE_ACTION_NAME .SERVICE_NAME .OPERATION;
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9.3 Response File Format

At the time the bulk protocol adapter starts processing an input request file, the corresponding results file
will be created in the results directory. The contents of this file are essentially the same as the
corresponding input file, with the only difference of the responses being appended at the end of request
command lines in the COMMANDS section. Command-response lines in the results file are added upon
order finishing, so the ordering might differ from the input file if there is more than one processing thread.
In case SOSA unexpectedly quits during the processing of a bulk request file, the corresponding
incomplete results file will be used to resume the job without re-processing the already completed
requests.

Responses adhere to the SCLP specification:

RESPONSE SOSA_CODE=SOSA_CODE, CODE=CODE PARAMS PARAM1=VALUE1, PARAM2=VALUEZ2, .. PARAMn=VALUEn;

For example:

RESPONSE SOSA_CODE=0, CODE=0 PARAMS N=7;

In case there is an error which prevents the request from even being processed as a SOSA order, such as
a bad SCLP command syntax or that the specified catalog service order or action does not exist, and so
there is no SOSA code to be output, a response like the following is expected:

RESPONSE ERROR ERROR_MESSAGE;

For instance:

RESPONSE ERROR “Failed to start synchronous dynamic order: Could not find a suitable service order or
action in the catalog for NAME=FO0, TYPE=BAR, ACTION=BAZ”;

9.4 Web Interface

Apart from directly placing request files in the configured request directory, bulk activation request files
may be uploaded through a Solution Container web interface. Opting for this approach also allows the
operator to schedule the time at which the bulk activation will begin.

9.4.1 Importing a Bulk Activation Request File

In order to import a bulk activation file, log into Solution Container and select MSA = Bulk Activations =
Import.

You will then be presented with the Import Bulk Activation File form, where you can select the desired
request file from your computer and may optionally schedule the processing start date. By default, the
request will be processed as soon as it is uploaded. In order to confirm the operation click on Actions 2
Import.
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» File | » Search | » SNMP Tool | » Configuration Management | » Administrator = » Inventory | » Help

» Actions

Import Bulk Activation File

» Bulk activation file:* | || Browse. .

» Processing start date:* 18/01/2013 11:50:18 |

9.4.2 listing Pending Bulk Activations

In order to list pending bulk activations select MSA = Bulk Activations = List. You will then be presented
with the Scheduled Bulk Activations listing:

»File »Search » SNMP Tool  » Configuration Management | » Administrator | » Inventory | » Help (0] |

Scheduled Bulk Activations

Original Filename Uploaded By Start Time
baz_request.bet admin 03/02/2013 12:00:54
foo_request txt admin 1810212013 11:57:40
bar_request bxt admin 24/02/2013 12:00:31

From here you can cancel or reschedule pending activations by selecting a row from the listing and
clicking the appropriate option from the Actions menu.

»File | »Search | » SNMP Tool | » Configuration Management | » Administrator | » Inventory | » Help (Er].

Reschedule Bulk Activation

» Hew processing start date=* 18/02/2013 11:57:40 i
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Appendix

Voice Mail WSDL

<?xml version="1.0" encoding="utf-8"?>
<wsdl:definitions targetNamespace="vms" xmlns:tns="vms"
xmlns:wsdlsoap="http://schemas.xmlsoap.org/wsd|/soap/"
xmlns:soap12="http://www.w3.0rg/2003/05/soap-envelope"
xmlns:ns1="http://mail.dto.op.web.ngmail.zte.com"
xmlns:xsd="http://www.w3.0rg/2001/XMLSchema"
xmlns:soapenc11="http://schemas.xmlsoap.org/soap/encoding/"
xmlns:soapenc12="http://www.w3.0rg/2003/05/soap-encoding"
xmlns:soap11="http://schemas.xmlsoap.org/soap/envelope/"
xmlns:wsd|="http://schemas.xmlsoap.org/wsdl/">
<wsdl:types>
<xsd:schema xmlins:xsd="http://www.w3.0rg/2001/XMLSchema"
targetNamespace="vms" elementFormDefauli="qualified"
attributeFormDefault="qualified">
<xsd:element name="CreateUser">
<xsd:complexType>
<xsd:sequence>
<xsd:element name="BoxNumber" type="xsd:string"
nillable="true" minOccurs="1" maxOccurs="1" />
<xsd:element name="OperID" type="xsd:string"
nillable="true" minOccurs="1" maxOccurs="1" />
<xsd:element name="OperPwd" type="xsd:string"
nillable="true" minOccurs="1" maxOccurs="1" />
<xsd:element name="ServiceClass" type="xsd:string"
nillable="true" minOccurs="1" maxOccurs="1" />
<xsd:element name="Language" type="xsd:string"
nillable="true" minOccurs="1" maxOccurs="1" />
<xsd:element name="Password" type="xsd:string"
nillable="true" minOccurs="1" maxOccurs="1" />
<xsd:element name="EntryAuthen" type="xsd:string"
nillable="true" minOccurs="1" maxOccurs="1" />
<xsd:element name="MessageNotify" type="xsd:string"
nillable="true" minOccurs="1" maxOccurs="1" />
<xsd:element name="UserName" type="xsd:string"
nillable="true" minOccurs="1" maxOccurs="1" />
<xsd:element name="Email" type="xsd:string"
nillable="true" minOccurs="1" maxOccurs="1" />
<xsd:element name="ZipCode" type="xsd:string"
nillable="true" minOccurs="1" maxOccurs="1" />
<xsd:element name="IDNumber" type="xsd:string"
nillable="true" minOccurs="1" maxOccurs="1" />
<xsd:element name="MWNType" type="xsd:string"
nillable="true" minOccurs="1" maxOccurs="1" />
<xsd:element name="MWNDest" type="xsd:string"
nillable="true" minOccurs="1" maxOccurs="1" />
<xsd:element name="LDOperatorCode" type="xsd:string"
nillable="true" minOccurs="1" maxOccurs="1" />
</xsd:sequence>
</xsd:complexType>
</xsd:element>
<xsd:element name="CreateUserResponse">
<xsd:complexType>
<xsd:sequence>
<xsd:element name="out" type="xsd:int" minOccurs="1"
maxOccurs="1" />
</xsd:sequence>
</xsd:complexType>
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</xsd:element>
<xsd:element name="DeleteUser">
<xsd:complexType>
<xsd:sequence>
<xsd:element name="BoxNumber" type="xsd:string'
nillable="true" minOccurs="1" maxOccurs="1" />
<xsd:element name="OperID" type="xsd:string"
nillable="true" minOccurs="1" maxOccurs="1" />
<xsd:element name="OperPwd" type="xsd:string"
nillable="true" minOccurs="1" maxOccurs="1" />
</xsd:sequence>
</xsd:complexType>
</xsd:element>
<xsd:element name="DeleteUserResponse">
<xsd:complexType>
<xsd:sequence>
<xsd:element name="out" type="xsd:int" minOccurs="1"
maxOccurs="1" />
</xsd:sequence>
</xsd:complexType>
</xsd:element>
<xsd:element name="QueryUser">
<xsd:complexType>
<xsd:sequence>
<xsd:element name="BoxNumber" type="xsd:string"
nillable="true" minOccurs="1" maxOccurs="1" />
<xsd:element name="OperlD" type="xsd:string"
nillable="true" minOccurs="1" maxOccurs="1" />
<xsd:element name="OperPwd" type="xsd:string"
nillable="true" minOccurs="1" maxOccurs="1" />
</xsd:sequence>
</xsd:complexType>
</xsd:element>
<xsd:element name="QueryUserResponse">
<xsd:complexType>
<xsd:sequence>
<xsd:element name="out"
type="ns1:UserInfoWebServicelnfo" nillable="true"
minOccurs="1" maxOccurs="1" />
</xsd:sequence>
</xsd:complexType>
</xsd:element>
<xsd:element name="ModifyUser">
<xsd:complexType>
<xsd:sequence>
<xsd:element name="BoxNumber" type="xsd:string"
nillable="true" minOccurs="1" maxOccurs="1" />
<xsd:element name="OperlD" type="xsd:string"
nillable="true" minOccurs="1" maxOccurs="1" />
<xsd:element name="OperPwd" type="xsd:string"
nillable="true" minOccurs="1" maxOccurs="1" />
<xsd:element name="UserStatus" type="xsd:string"
nillable="true" minOccurs="1" maxOccurs="1" />
<xsd:element name="ServiceClass" type="xsd:string"
nillable="true" minOccurs="1" maxOccurs="1" />
<xsd:element name="Language" type="xsd:string"
nillable="true" minOccurs="1" maxOccurs="1" />
<xsd:element name="Password" type="xsd:string"
nillable="true" minOccurs="1" maxOccurs="1" />
<xsd:element name="EntryAuthen" type="xsd:string"
nillable="true" minOccurs="1" maxOccurs="1" />
<xsd:element name="MessageNotify" type="xsd:string"
nillable="true" minOccurs="1" maxOccurs="1" />
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<xsd:element name="UserName" type="xsd:string"
nillable="true" minOccurs="1" maxOccurs="1" />
<xsd:element name="Email" type="xsd:string"
nillable="true" minOccurs="1" maxOccurs="1" />
<xsd:element name="ZipCode" type="xsd:string"
nillable="true" minOccurs="1" maxOccurs="1" />
<xsd:element name="IDNumber" type="xsd:string"
nillable="true" minOccurs="1" maxOccurs="1" />
<xsd:element name="MWNType" type="xsd:string"
nillable="true" minOccurs="1" maxOccurs="1" />
<xsd:element name="MWNDest" type="xsd:string"
nillable="true" minOccurs="1" maxOccurs="1" />
<xsd:element name="LDOperatorCode" type="xsd:string"
nillable="true" minOccurs="1" maxOccurs="1" />
</xsd:sequence>
</xsd:complexType>
</xsd:element>
<xsd:element name="ModifyUserResponse">
<xsd:complexType>
<xsd:sequence>
<xsd:element name="out" type="xsd:int" minOccurs="1"
maxOccurs="1" />
</xsd:sequence>
</xsd:complexType>
</xsd:element>
</xsd:schema>
<xsd:schema xmlins:xsd="http://www.w3.0rg/2001/XMLSchema"
targetNamespace="http://mail.dto.op.web.ngmail.zte.com"
elementFormDefault="qualified"
attributeFormDefault="qualified">
<xsd:complexType name="UserlnfoWebServicelnfo">
<xsd:sequence>
<xsd:element name="IDNumber" type="xsd:string"
minOccurs="0" nillable="true" />
<xsd:element name="LDOperatorCode" type="xsd:string"
minOccurs="0" nillable="true" />
<xsd:element name="MWNDest" type="xsd:string"
minOccurs="0" nillable="true" />
<xsd:element name="MWNType" type="xsd:string"
minOccurs="0" nillable="true" />
<xsd:element name="email" type="xsd:string" minOccurs="0"
nillable="true" />
<xsd:element name="entryAuthen" type="xsd:string"
minOccurs="0" nillable="true" />
<xsd:element name="language" type="xsd:string"
minOccurs="0" nillable="true" />
<xsd:element name="messageNotify" type="xsd:string"
minOccurs="0" nillable="true" />
<xsd:element name="password" type="xsd:string"
minOccurs="0" nillable="true" />
<xsd:element name="resultcode" type="xsd:int"
minOccurs="0" />
<xsd:element name="serviceClass" type="xsd:string"
minOccurs="0" nillable="true" />
<xsd:element name="userName" type="xsd:string"
minOccurs="0" nillable="true" />
<xsd:element name="userStatus" type="xsd:string"
minOccurs="0" nillable="true" />
<xsd:element name="zipCode" type="xsd:string"
minOccurs="0" nillable="true" />
</xsd:sequence>
</xsd:complexType>
</xsd:schema>
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</wsdl:types>
<wsdl:message name="CreateUserRequest">
<wsdl:part name="parameters" element="tns:CreateUser" />
</wsd|:message>
<wsdl:message name="ModifyUserResponse">
<wsdl:part name="parameters"
element="tns:ModifyUserResponse" />
</wsd|:message>
<wsdl:message name="QueryUserResponse">
<wsdl:part name="parameters" element="tns:QueryUserResponse" />
</wsd|:message>
<wsdl:message name="ModifyUserRequest">
<wsdl:part name="parameters" element="tns:ModifyUser" />
</wsd|:message>
<wsdl:message name="CreateUserResponse">
<wsdl:part name="parameters"
element="tns:CreateUserResponse" />
</wsd|:message>
<wsdl:message name="QueryUserRequest">
<wsdl:part name="parameters" element="tns:QueryUser" />
</wsdl:message>
<wsdl:message name="DeleteUserRequest">
<wsdl:part name="parameters" element="tns:DeleteUser" />
</wsd|:message>
<wsd|:message name="DeleteUserResponse">
<wsdl:part name="parameters"
element="tns:DeleteUserResponse" />
</wsdl:message>
<wsdl:portfType name="lvmsbossPortType">
<wsdl:operation name="CreateUser">
<wsdl:input name="CreateUserRequest"
message="ns:CreateUserRequest" />
<wsdl:output name="CreateUserResponse"
message="tns:CreateUserResponse" />
</wsdl:operation>
<wsdl:operation name="DeleteUser">
<wsdl:input name="DeleteUserRequest"
message="tns:DeleteUserRequest" />
<wsd|:output name="DeleteUserResponse"
message="tns:DeleteUserResponse" />
</wsdl:operation>
<wsdl:operation name="QueryUser">
<wsdl:input name="QueryUserRequest"
message="tns:QueryUserRequest" />
<wsdl:output name="QueryUserResponse"
message="tns:QueryUserResponse" />
</wsdl:operation>
<wsdl:operation name="ModifyUser">
<wsdl:input name="ModifyUserRequest"
message="tns:ModifyUserRequest" />
<wsdl:output name="ModifyUserResponse"
message="tns:ModifyUserResponse" />
</wsdl:operation>
</wsdl:porfType>
<wsdl:binding name="IvmsbossHttpBinding"
type="tns:lvmsbossPortType">
<wsdlsoap:binding style="document"
transport="http://schemas.xmlsoap.org/soap/http" />
<wsdl:operation name="CreateUser">
<wsdlsoap:operation soapAction="" />
<wsdl:input name="CreateUserRequest">
<wsdlsoap:body use="literal" />
</wsdl:input>
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<wsdl:output name="CreateUserResponse">
<wsdlsoap:body use="literal" />
</wsdl:output>
</wsdl:operation>
<wsdl:operation name="DeleteUser">
<wsdlsoap:operation soapAction="" />
<wsdl:input name="DeleteUserRequest">
<wsdlsoap:body use="literal" />
</wsdl:input>
<wsdl:output name="DeleteUserResponse">
<wsdlsoap:body use="literal" />
</wsdl:output>
</wsdl:operation>
<wsdl:operation name="QueryUser">
<wsdlsoap:operation soapAction="" />
<wsdl:input name="QueryUserRequest">
<wsdlsoap:body use="literal" />
</wsdl:input>
<wsdl:output name="QueryUserResponse">
<wsdlsoap:body use="literal" />
</wsdl:output>
</wsdl:operation>
<wsdl:operation name="ModifyUser">
<wsdlsoap:operation soapAction="" />
<wsdl:input name="ModifyUserRequest">
<wsdlsoap:body use="literal" />
</wsdl:input>
<wsd|:output name="ModifyUserResponse">
<wsdlsoap:body use="literal" />
</wsdl:output>
</wsdl:operation>
</wsdl:binding>
<wsdl:service name="Ivmsboss">
<wsdl:port name="lvmsbossHttpPort"
binding="tns:lvmsbossHttpBinding">
<wsdlsoap:address location="http://10.130.48.146:88/vmsboss/Ilvmsboss" />
</wsd|:port>
</wsdl:service>
</wsd|:definitions>
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